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Preface

How to Use This Guide

Purpose of This
Guide

This guide is written for the training of principle investigators and laboratory staff who 
operate and maintain the Applied Biosystems 3730/3730xl DNA Analyzers.

Assumptions This guide assumes the following background:

• Familiarity with the Microsoft® Windows® 2000 operating system. 
• Knowledge of techniques for handling and preparing DNA samples for sequencing.
• A general understanding of hard drives and data storage, file transfers, and copying 

and pasting.

Text Conventions This guide uses the following conventions: 

• Bold indicates user action. For example:
Type 0, then press Enter for each of the remaining fields.

• Italic text indicates new or important words and is also used for emphasis. For 
example:
Before analyzing, always prepare fresh matrix.

• A right arrow bracket (>) separates successive commands you select from a drop-
down or shortcut menu. For example:
Select File > Open > Spot Set.
Right-click the sample row, then select View Filter > View All Runs.

User Attention
Words

Two user attention words appear in Applied Biosystems user documentation. Each word 
implies a particular level of observation or action as described below:

Note: Provides information that may be of interest or help but is not critical to the use of 
the product.

IMPORTANT! Provides information that is necessary for proper instrument operation, 
accurate chemistry kit use, or safe use of a chemical.

Examples of the user attention words appear below:

Note: The size of the column affects the run time.

Note: The Calibrate function is also available in the Control Console.

IMPORTANT! To verify your client connection to the database, you need a valid Oracle 
user ID and password.

IMPORTANT! You must create a separate Sample Entry Spreadsheet for each 
96-well plate.
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Safety Alert
Words

Safety alert words also appear in user documentation. For more information, see “Safety 
Alert Words” on page xi 

Send Us Your Comments
Applied Biosystems welcomes your comments and suggestions for improving its user 
documents. You can e-mail your comments to:

techpubs@appliedbiosystems.com

mailto:techpubs@appliedbiosystems.com
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Safety

Safety Alert Words
Four safety alert words appear in Applied Biosystems user documentation. Each word 
implies a particular level of observation or action, as described below:

IMPORTANT! Indicates information that is necessary for proper instrument operation, 
accurate chemistry kit use, or safe use of a chemical.

Indicates a potentially hazardous situation that, if not avoided, may result in minor or 
moderate injury. It may also be used to alert against unsafe practices, damage to an 
instrument, or loss of data.

Indicates a potentially hazardous situation that, if not avoided, could result in death or 
serious injury.

Indicates an imminently hazardous situation that, if not avoided, will result in death or 
serious injury.

Sources of Safety Information

For System Operators

Operational safety information for the Applied Biosystems 3730/3730xl DNA Analyzer 
is provided in the following documents, which are included with each system.

Material Safety Data Sheets (MSDSs)

MSDSs provide information you need to store, handle, transport, and dispose of 
chemicals safely. 
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Symbols on Instruments

Electrical Symbols

The following electrical symbols may be displayed on Applied Biosystems instruments.

Safety Symbols

The following safety symbols may be displayed on Applied Biosystems instruments. 
Each symbol may appear by itself or in combination with text that explains the relevant 
hazard (see “Safety Labels on Instruments” on page xiii). These safety symbols may also 
appear next to DANGERS, WARNINGS, and CAUTIONS that occur in the text of this 
and other product-support documents.

Symbol Description Symbol Description

Indicates the On position of the 
main power switch.

Indicates a terminal that may be 
connected to the signal ground 
reference of another instrument. 
This is not a protected ground 
terminal.Indicates the Off position of the 

main power switch.
Indicates a protective grounding 
terminal that must be connected 
to earth ground before any other 
electrical connections are made 
to the instrument.

Indicates the On/Off position of 
a push-push main power switch.

Indicates a terminal that can 
receive or supply alternating 
current or voltage.

Indicates a terminal that can 
receive or supply alternating or 
direct current or voltage.

Symbol Description Symbol Description

Indicates that you should 
consult the manual for further 
information and to proceed with 
appropriate caution.

Indicates the presence of a laser 
inside the instrument and to 
proceed with appropriate 
caution.

Indicates the presence of an 
electrical shock hazard and to 
proceed with appropriate 
caution.

Indicates the presence of 
moving parts and to proceed 
with appropriate caution.

Indicates the presence of a hot 
surface or other high-
temperature hazard and to 
proceed with appropriate 
caution. 
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Safety Labels on Instruments
The following CAUTION, WARNING, and DANGER statements may be displayed on 
Applied Biosystems instruments in combination with the safety symbols described in the 
preceding section. 

English Francais

CAUTION Hazardous chemicals. Read the 
Material Safety Data Sheets (MSDSs) before 
handling.

ATTENTION Produits chimiques dangeureux. 
Lire les fiches techniques de sûreté de 
matériels avant la manipulation des produits.

CAUTION Hazardous waste. Read the waste 
profile (if any) in the site preparation guide for 
this instrument before handling or disposal.

ATTENTION Déchets dangereux. Lire les 
renseignements sur les déchets avant de les 
manipuler ou de les éliminer.

CAUTION Hazardous waste. Refer to 
MSDS(s) and local regulations for handling 
and disposal.

ATTENTION Déchets dangereux. Lire les 
fiches techniques de sûreté de matériels et la 
régulation locale associées à la manipulation 
et l'élimination des déchets.

WARNING Hot lamp. AVERTISSEMENT Lampe brûlante.

WARNING Hot. Replace lamp with an 
Applied Biosystems lamp.

AVERTISSEMENT Composants brûlants. 
Remplacer la lampe par une lampe 
Applied Biosystems.

CAUTION Hot surface. ATTENTION Surface brûlante.

DANGER High voltage. DANGER Haute tension.

WARNING To reduce the chance of electrical 
shock, do not remove covers that require tool 
access. No user-serviceable parts are inside. 
Refer servicing to Applied Biosystems 
qualified service personnel.

AVERTISSEMENT Pour éviter les risques 
d'électrocution, ne pas retirer les capots dont 
l'ouverture nécessite l'utilisation d'outils. 
L’instrument ne contient aucune pièce 
réparable par l ’utilisateur. Toute intervention 
doit être effectuée par le personnel de service 
qualifié de Applied Biosystems.

DANGER Class II laser radiation present 
when open and interlock defeated. Do not 
stare directly into the beam

DANGER de Class II rayonnement laser en 
cas d'ouverture et d'une neutralisation des 
dispositifs de securite. Eviter toute exposition 
directe avec le faisceau.

DANGER Class II laser radiation present 
when open. Do not stare directly into the 
beam. 

DANGER de Class II rayonnement laser en 
cas d'ouverture. Eviter toute exposition 
directe avec le faisceau.

CAUTION Moving parts. ATTENTION Parties mobiles.
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General Instrument Safety

PHYSICAL INJURY HAZARD. Use this product only as specified in this document. 
Using this instrument in a manner not specified by Applied Biosystems may result in 
personal injury or damage to the instrument.

Moving and Lifting the Instrument

PHYSICAL INJURY HAZARD. The instrument is to be moved and positioned only by 
the personnel or vendor specified in the applicable site preparation guide. If you decide 
to lift or move the instrument after it has been installed, do not attempt to lift or move the 
instrument without the assistance of others, the use of appropriate moving equipment, 
and proper lifting techniques. Improper lifting can cause painful and permanent back 
injury. Depending on the weight, moving or lifting an instrument may require two or 
more persons.

Moving and Lifting Stand-Alone Computers and Monitors

Do not attempt to lift or move the computer or the monitor without the assistance of 
others. Depending on the weight of the computer and/or the monitor, moving them may 
require two or more people.

Before lifting the computer and/or the monitor:

• Make sure that you have a secure, comfortable grip on the computer or the monitor 
when lifting.

• Make sure that the path from where the object is to where it is being moved is clear 
of obstructions.

• Do not lift an object and twist your torso at the same time.
• Keep your spine in a good neutral position while lifting with your legs.
• Participants should coordinate lift and move intentions with each other before 

actually lifting and carrying.
• Instead of lifting the object from the packing box, carefully tilt the box on its side 

and hold it stationary while someone slides the contents out of the box.

Operating the Instrument

Ensure that anyone who operates the instrument has:

• Received instructions in both general safety practices for laboratories and specific 
safety practices for the instrument.

• Read and understood all applicable Material Safety Data Sheets (MSDSs).
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Chemical Safety

Chemical Hazard Warnings

CHEMICAL HAZARD. Before handling any chemicals, refer to the Material Safety 
Data Sheet (MSDS) provided by the manufacturer, and observe all relevant precautions.

CHEMICAL HAZARD. All chemicals in the instrument, including liquid in the lines, 
are potentially hazardous. Always determine what chemicals have been used in the 
instrument before changing reagents or instrument components. Wear appropriate 
eyewear, protective clothing, and gloves when working on the instrument.

CHEMICAL HAZARD. Four-liter reagent and waste bottles can crack and leak. Each 
4-liter bottle should be secured in a low-density polyethylene safety container with the 
cover fastened and the handles locked in the upright position. Wear appropriate eyewear, 
clothing, and gloves when handling reagent and waste bottles.

MSDSs

Chemical manufacturers supply current Material Safety Data Sheets (MSDSs) with 
shipments of hazardous chemicals to new customers. They also provide MSDSs with the 
first shipment of a hazardous chemical to a customer after an MSDS has been updated. 
MSDSs provide the safety information you need to store, handle, transport, and dispose 
of the chemicals safely.

Each time you receive a new MSDS packaged with a hazardous chemical, be sure to 
replace the appropriate MSDS in your files.

Obtaining MSDSs 

You can obtain from Applied Biosystems the MSDS for any chemical supplied by 
Applied Biosystems. This service is free and available 24 hours a day. 

To obtain MSDSs:
1. Go to https://docs.appliedbiosystems.com/msdssearch.html

2. In the Search field, type in the chemical name, part number, or other information 
that appears in the MSDS of interest. select the language of your choice, then click 
Search.

3. Find the document of interest, right-click the document title, then select any of the 
following:

• Open – To view the document
• Print Target – To print the document
• Save Target As – To download a PDF version of the document to a 

destination that you choose

4. To have a copy of a document sent by fax or e-mail, select Fax or E-mail to the left 
of the document title in the Search Results page, then click RETRIEVE 
DOCUMENTS at the end of the document list.

5. After you enter the required information, click View/Deliver Selected Documents 
Now.
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Chemical Safety Guidelines

• Read and understand the MSDSs provided by the chemical manufacturer before you 
store, handle, or work with any chemicals or hazardous materials.

• Minimize contact with chemicals. When handling chemicals, wear appropriate 
personal protective equipment such as safety glasses, gloves, and protective 
clothing. For additional safety guidelines, consult the MSDS.

• Minimize the inhalation of chemicals. Do not leave chemical containers open. Use 
only with adequate ventilation (for example, a fume hood). For additional safety 
guidelines, consult the MSDS. 

• Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the 
cleanup procedures recommended in the MSDS.

• Comply with all local, state/provincial, and/or national laws and regulations related 
to chemical storage, handling, and disposal.
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Chemical Waste Safety

CHEMICAL WASTE HAZARD. Some wastes produced by the operation of the 
instrument or system are potentially hazardous and can cause injury, illness, or death.

Chemical Waste Safety Guidelines

• Read and understand the MSDSs for the chemicals in a waste container before you store, 
handle, or dispose of chemical waste.

• Provide primary and secondary waste containers
• Minimize contact with and inhalation of chemical waste. When handling chemicals, wear 

appropriate protective equipment such as safety glasses, gloves, and protective clothing.
• Handle chemical wastes in a fume hood.
• After you empty a chemical waste container, seal it with the cap provided.
• Dispose of the contents of a waste container in accordance with good laboratory practices 

and local, state/provincial, and/or national environmental and health regulations.

Waste Profiles

A waste profile for the 3730/3730xl DNA analyzer is provided in the 3730/3730xl DNA 
Analyzer Site Preparation Guide. 

Waste profiles show the percentage compositions of the reagents in the waste stream 
generated during installation and during a typical user application, even though the 
typical application may not be used in your laboratory.

The waste profiles help you plan for the handling and disposal of waste generated by 
operation of the instrument. Read the waste profiles and all applicable MSDSs before 
handling or disposing of chemical waste.

Waste Disposal

If potentially hazardous waste is generated when you operate the instrument, you must:

• Characterize (by analysis if necessary) the waste generated by the particular 
applications, reagents, and substrates used in your laboratory.

• Ensure the health and safety of all personnel in your laboratory.
• Ensure that the instrument waste is stored, transferred, transported, and disposed of 

according to all local, state/provincial, and/or national regulations.

IMPORTANT! Radioactive or biohazardous materials may require special handling, and 
disposal limitations may apply.
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Electrical Safety

Shock Hazards

ELECTRICAL SHOCK HAZARD. Severe electrical shock can result from operating 
the 3730/3730xl DNA analyzer without its instrument panels in place. Do not remove 
instrument panels. High-voltage contacts are exposed when instrument panels are 
removed from the instrument.

Fuses

ELECTRICAL SHOCK HAZARD. Improper fuses or high-voltage supply can 
damage the instrument wiring system and cause a fire. Before turning on the 3730/3730xl 
DNA analyzer, verify that the fuses are properly installed and that the instrument voltage 
matches the power supply in your laboratory.

FIRE HAZARD. For continued protection against the risk of fire, replace fuses only 
with fuses of the type and rating specified for the instrument.

Power Supply 

ELECTRICAL HAZARD. Grounding circuit continuity is vital for the safe operation 
of equipment. Never operate equipment with the grounding conductor disconnected.

ELECTRICAL HAZARD. Use properly configured and approved line cords for the 
voltage supply in your facility.

ELECTRICAL HAZARD. Plug the system into a properly grounded receptacle with 
adequate current capacity.

Overvoltage Rating

The 3730/3730xl DNA Analyzer system has an installation (overvoltage) category of II, 
and is classified as portable equipment

Physical Hazard Safety

Moving Parts

PHYSICAL INJURY HAZARD. Moving parts can crush and cut. Keep hands clear of 
moving parts while operating the 3730/3730xl DNA Analyzer. Disconnect power before 
servicing the 3730/3730xl DNA Analyzer.

PHYSICAL INJURY HAZARD. Do not operate the 3730/3730xl DNA Analyzer 
without the arm shield in place. Keep hands out of the deck area when the 3730/3730xl 
instrument autosamplers are moving.
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Solvents and Pressurized Fluids

PHYSICAL INJURY HAZARD. Always wear eye protection when working with 
solvents or any pressurized fluids.

PHYSICAL INJURY HAZARD. To avoid hazards associated with high-pressure fluids 
in polymeric tubing:

• Be aware that Radel® tubing is a polymeric material. Use caution when working with 
any polymer tubing that is under pressure.

• Always wear eye protection when in proximity to pressurized polymer tubing.
• Extinguish all nearby flames if you use flammable solvents.
• Do not use Radel® tubing that has been severely stressed or kinked.
• Do not use Radel® tubing with tetrahydrofuran or concentrated nitric and sulfuric acids.
• Be aware that methylene chloride and dimethyl sulfoxide cause Radel® tubing to swell 

and greatly reduce the rupture pressure of the tubing.
• Be aware that high solvent flow rates (~40 mL/min) may cause a static charge to build up 

on the surface of the tubing. Electrical sparks may result.

Biological Hazard Safety

BIOHAZARD. Biological samples such as tissues, body fluids, and blood of humans 
and other animals have the potential to transmit infectious diseases. Read and follow the 
guidelines published in:

• U.S. Department of Health and Human Services guidelines published in Biosafety in 
Microbiological and Biomedical Laboratories (stock no. 017-040-00547-4)

• Occupational Safety and Health Standards, Toxic and Hazardous Substances 
(29 CFR §1910.1030).

Additional information about biohazard guidelines is available at:

http://www.cdc.gov

Follow all applicable local, state/provincial, and/or national regulations. Wear 
appropriate protective eyewear, clothing, and gloves.

Laser Safety

Laser Classification

The 3730/3730xl DNA Analyzer uses a laser. Under normal operating conditions, the 
instrument laser is categorized as a Class I laser. When safety interlocks are disabled 
during certain servicing procedures, the laser can cause permanent eye damage, and, 
therefore, is classified under those conditions as a Class IIIb laser.

The 3730/3730xl DNA Analyzer laser has been tested to and complies with the 
“Radiation Control for Health and Safety Act of 1968 Performance Standard CFR 1040.”
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The 3730/3730xl DNA Analyzer laser has been tested to and complies with standard 
EN60825-1, “Radiation Safety of Laser Products, Equipment Classification, 
Requirements, and User’s Guide.”

Laser Safety Requirements

To ensure safe laser operation:

• The system must be installed and maintained by an Applied Biosystems Technical 
Representative.

• All instrument panels must be in place on the instrument while the instrument is 
operating. When all panels are installed, there is no detectable radiation present. If any 
panel is removed when the laser is operating (during service with safety interlocks 
disabled), you may be exposed to laser emissions in excess of the Class I rating.

• Do not remove safety labels or disable safety interlocks.

Additional Laser Safety Information

Refer to the user documentation provided with the laser for additional information on 
government and industry safety regulations.

LASER HAZARD. Lasers can burn the retina causing permanent blind spots. Never 
look directly into the laser beam. Remove jewelry and other items that can reflect the 
beam into your eyes. Do not remove the instrument top or front panels. Wear proper eye 
protection and post a laser warning sign at the entrance to the laboratory if the top or 
front panels are removed for service.

LASER BURN HAZARD. An overheated laser can cause severe burns if it comes in 
contact with the skin. DO NOT operate the laser when it cannot be cooled by its cooling 
fan. Always wear appropriate laser safety goggles.

Bar Code Scanner Laser Safety

Laser Classification

The bar code scanner included with the 3730/3730xl DNA Analyzer is categorized as a 
Class II laser.

Laser Safety Requirements

Class II lasers are low-power, visible-light lasers that can damage the eyes. Never 
look directly into the laser beam. The scanner is designed to prevent human access to 
harmful levels of laser light during normal operation, user maintenance, or during 
prescribed service operations.

LASER HAZARD. Class II lasers can cause damage to eyes. Avoid looking into a Class 
II laser beam or pointing a Class II laser beam into another person’s eyes.
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Computer Workstation Safety
Correct ergonomic configuration of your workstation can reduce or prevent effects such 
as fatigue, pain, and strain. Minimize or eliminate these effects by configuring your 
workstation to promote neutral or relaxed working positions.

MUSCULOSKELETAL AND REPETITIVE MOTION HAZARD. These hazards 
are caused by potential risk factors that include but are not limited to repetitive motion, 
awkward posture, forceful exertion, holding static unhealthy positions, contact pressure, 
and other workstation environmental factors.

• Use equipment that comfortably supports you in neutral working positions and allows 
adequate accessibility to the keyboard, monitor, and mouse.

• Position the keyboard, mouse, and monitor to promote relaxed body and head postures.

Safety and Electromagnetic Compatibility (EMC) Standards

U.S. and Canadian Safety Standards

This instrument has been tested to and complies with standard UL 3101-1, “Safety 
Requirements for Electrical Equipment for Laboratory Use, Part 1: General Requirements.”

This instrument has been tested to and complies with standard CSA 1010.1, “Safety 
Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use, 
Part 1: General Requirements.” 

Canadian EMC Standard

This instrument has been tested to and complies with ICES-001, Issue 3: Industrial, 
Scientific, and Medical Radio Frequency Generators.

European Safety and EMC Standards 

Safety

This instrument meets European requirements for safety (Low Voltage Directive 
73/23/EEC). This instrument has been tested to and complies with standards EN 61010-
1:2001, “Safety Requirements for Electrical Equipment for Measurement, Control and 
Laboratory Use, Part 1: General Requirements” and EN 61010-2-010, “Particular 
Requirements for Laboratory Equipment for the Heating of Materials.”

EMC

This instrument meets European requirements for emission and immunity (EMC 
Directive 89/336/EEC). This instrument has been tested to and complies with standard 
EN 61326 (Group 1, Class B), “Electrical Equipment for Measurement, Control and 
Laboratory Use – EMC Requirements.”
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Australian EMC Standards

This instrument has been tested to and complies with standard AS/NZS 2064, “Limits 
and Methods Measurement of Electromagnetic Disturbance Characteristics of Industrial, 
Scientific, and Medical (ISM) Radio-frequency Equipment.”
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Instrument and Parts

Interior light button

Power button (on/off)

description 4

Status lights

description 5

Stacker door 
indicator light

Oven door

Stacker door

Pump Block

maintenance 157

Polymer supply tube

Polymer reservoir

filling 13
   installing 13

Anode buffer jar

filling 17
   installing 17

Lower polymer block

   cleaning 157

Capillary array

installing 9

Waste reservoir

installing 16

Interconnect tube

Water reservoir

filling 16
installing 16

Buffer reservoir

filling 16
installing 16

Tray buttonPower button (on/off)

description 4

Behind the oven door

Polymer Delivery Pump (PDP)
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Waste fitting

PDP motor cover
PDP motor

Double-tapered ferrule

Array port

Capillary array tip

Water trap
Piston

Pump block

Check valve

Polymer supply
bottle cap with hole

Mounting pin

Polymer supply tube

Syringe fitting

Polymer supply bottle

Lower polymer block

Buffer fill-line

Buffer jar (67mL anode reservoir)

Electrode

Overflow hole

Water seal

Capillary array

Buffer valve pin

O-ring

Mounting pin
Mounting

pin

Interconnect tube

Mounting pin

Capillary array knob Pump chamber

Polymer Delivery Pump Detail
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Overview 
This chapter explains how to prepare the instrument 
for a run by installing the capillary array, buffer, and 
reservoirs.

Powering On the Computer and 
3730/3730xl Instrument

1. Press the power button on the monitor to turn it 
on.

2. Press the power button on the computer to turn it 
on.

3. In the Log On to Windows dialog box:
a. In the User Name field, enter your user 

name.
b. In the Password field, enter your password.
c. Click .

4. Close the oven door.

5. Close the stacker drawer.

6. Close the instrument door.

7. Wait until the monitor displays the desktop of the 
Windows® operating system.

3a

3b

Stacker drawer

Instrument door
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8. Press the power button on the 3730/3730xl 
instrument to turn it on.

Yes

Yes

No

No

>00:05:00Yes

Page
8

Page
6

Page
7

Initializing

Downloading 
firmware

Performing 
diagnostics

00:00:10

00:00:30

00:00:30

Ready

Status Status 
Light Action

• The instrument is ready

• An automated wizard 
operation is in progress with 
the instrument door closed

Go to 
page 8.

• A run is in progress

• The instrument cannot 
communicate with the 
computer.

Go to 
page 7.

• The instrument is 
downloading firmware

• The instrument is performing 
diagnostics

• The oven door is open

• The instrument door is open

• The buffer reservoir is not 
installed

• The capillary array is not 
installed

• An automated wizard 
operation is in progress with 
the instrument door open

Go to 
page 7.

• The instrument has detected 
a problem

Go to 
page 7.

flashing green

flashing yellow

solid red

solid green

solid yellow
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Troubleshooting

The instrument displays a flashing yellow light.

Determine the source of the problem as follows:

1. Press on the instrument door to ensure that it is 
closed.

If the 3730/3730xl instrument displays the green 
status light, then the instrument door was open. Go 
to page 8

2. If the 3730/3730xl instrument continues to display the 
flashing yellow light:

a. Open the instrument door.

b. Press on the oven door to verify that it is closed.

c. Close the instrument door. 

If the 3730/3730xl instrument displays the green 
status light, then the oven door was open. Go to 
page 8

3. If the 3730/3730xl instrument continues to display the 
flashing yellow light:

a. Open the instrument door.

b. Open the oven door.

c. Check that the buffer reservoir and capillary array 
are installed. 

d. Close the oven door. 

e. Close the instrument door.

Instrument door

Oven door

Buffer reservoir (installed)

Capillary array (installed)

OK – Go to page 8.

Buffer reservoir (not installed)

Capillary array (not installed)

OK – Go to page 8.

Capillary array (installed)
Buffer reservoir (not installed)
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The Instrument displays a solid yellow light.

Determine the source of the problem as follows:

Verify that the ...

1. Monitor displays the desktop of the Windows operating system. 

2. Ethernet cable is connected to the back of the 3730/3730xl instrument.

3. Other end of the Ethernet cable is connected to the computer.

4. Instrument door is closed.

5. Buffer, water, and waste reservoirs are in place.

6. 3730User account password is functional.

If the instrument continues to display the solid yellow light, contact Applied Biosystems technical support or your service 
representative for further assistance.

The Instrument displays a solid red light.

Determine the source of the problem as follows:

1. If the instrument continues to display the solid red 
light:

a. Turn off the instrument.

b. Wait for 30 seconds.

c. Turn on the instrument.

2. If the instrument continues to display the solid red 
light:

a. Start the 3730/3730xl Data Collection Software as 
explained on page 8.

b. In the Tree pane of the Data Collection Software, 
double-click GA Instruments > ga3730 > 

instrument name > Instrument Status > 
Event Log.

c. In the Event Log view, find the last message in the 
log file.

d. Using the error code, perform the required tasks 
to fix the problem.

3. If the instrument continues to display the solid red 
light, contact Applied Biosystems technical support 
or your service representative for further assistance.

Troubleshooting  (continued)
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Starting the 3730/3730xl Data Collection Software
1. Select > Programs > 

Applied Biosystems > 
Unified Data Collection > 
Run Unified Data Collection v2.0.

The data collection software opens the Service 
Console dialog box.

Wait for the Service Console dialog box to open 
the applications of the data collection software.

When all applications are running (green 
squares), the Data Collection software opens the 
Data Collection Viewer.

Red circles indicate that 
applications of the data 
collection software are not 
running.

Applications of the 
data collection 
software are running

00:00:00

<00:01:00

>00:01:00

RunningStartingNot running
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Installing the Capillary Array
Required Materials

• Capillary array, 96- or 48-capillary
• Lab wipes, lint-free
• Gloves

Guidelines for Capillary Use

• Do not bend the capillaries
• Store capillary arrays using a buffer reservoir and 

the header shipping cover (for storing 
information see, page 168).

Installing a New or Used Capillary Array

1. Close the instrument door.

2. In the Data Collection software, select 
GA Instruments > ga3730 > 
instrument name >.

o

3. On the toolbar, select 
Wizards > Install Array Wizard.

4. Install the array as instructed by the Array 
Wizard.

After Replacing the Capillary Array

• Perform a spatial calibration

CHEMICAL HAZARD. POP-7 
polymer may cause eye, skin, and respiratory tract 
irritation. Please read the MSDS, and follow the handling 
instructions. Wear appropriate protective eyewear, 
clothing, and gloves. Use for research and development 
purposes only.

Buffer reservoir

Header 
shipping cover

IMPORTANT! Wear gloves when you 
handle the capillary array.

Instrument door
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Replacing the Polymer
Note: This section may be skipped if you have 
installed a capillary array using the Install Array 
wizard during the initial activation of the instrument. 

Required Materials

• POP-7 polymer
• Wipes, lint-free
• Gloves

Guidelines for Polymer Use

• Check the polymer blocks and lines daily 
for bubbles. 

• Ensure that you have enough polymer for 
operation:
– A 96-capillary run uses approximately 250 µL 

of polymer 
– A 48-capillary run uses approximately 110 µL 

of polymer. 

When to Replace the Polymer

Replace the polymer on the instrument:

•  Weekly (polymer lifetime is 7 days at 25 °C)
• If insufficient polymer remains for the planned 

run set

CHEMICAL HAZARD. POP-7 
polymer may cause eye, skin, and respiratory tract 
irritation. Please read the MSDS, and follow the handling 
instructions. Wear appropriate protective eyewear, 
clothing, and gloves. Use for research and development 
purposes only.

POP-7 Storage 

Su M T W Th F S

2 °C to 8 °C Until expiration 
date on the bottle

IMPORTANT! Failure to replace expired/old polymer 
may lead to loss of resolution and data quality.

IMPORTANT! Wear gloves when you 
handle polymer.
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1. Close the instrument door.

2. In the Data Collection software, select 
GA Instruments > ga3730 > 
instrument name >.

3. On the toolbar, select Wizards > Change 
Polymer Wizard.

4. Change the polymer as instructed by the Change 
Polymer wizard.

Instrument door
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Preparing Buffer and Filling the Reservoirs
Required Materials

• Retainer, buffer/water/waste
• Septa 
• Reservoir caps
• Reservoir, buffer/water/waste
• Plate base, water/waste
• Plate base, buffer
• Water, deionized, 180 mL plus, 160 mL for water 

and waste reservoirs
• 10X Genetic Analyzer Running Buffer with 

EDTA, 20 mL
• Graduated cylinder, 250-mL 
• Gloves, silicone-free, powder-free

Guidelines for Buffer Use

The 1X run buffer can be stored at:

• 2 to 8 °C for up to 1 month
• Room temperature for 1 week

When to Change the Buffer, Water, and Waste

Replace the buffer in the reservoirs every 48 hours, or 
before each batch of runs.

CHEMICAL HAZARD. Running 
Buffer with EDTA. Please read the MSDS, and follow 
the handling instructions. Wear appropriate protective 
eyewear, clothing, and gloves.

1X 
3730
Run

Buffer

Buffer Storage Conditions

Option A Option B

Su M T W Th F S

2 °C to 
8 °C

1 month

Su M T W Th F S

20 °C to 
25 °C

7 days

IMPORTANT! Failure to replace buffer may lead to 
loss of resolution and data quality.
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Preparing the 1X Run Buffer

1. Add 20 mL 10X running buffer with EDTA into 
a graduated cylinder.

2. Add 180 mL (qs) deionized water to bring the 
total volume to 200 mL.

3. Mix well and set aside.

Filling the Water and Buffer Reservoirs

1. Close the instrument door.

2. Press the Tray button to bring the autosampler to 
the forward position.

3. Wait for the autosampler to stop moving and for 
the green status light to illuminate, before you 
open the instrument door.

4. Unplug the buffer reservoir. Remove the buffer, 
water, and waste reservoir assemblies from the 
instrument.

5. Disassemble each reservoir assembly and empty 
the contents of the reservoirs into an aqueous 
waste container.

IMPORTANT! Wear gloves when you 
handle running buffer with EDTA.

180 mL DI water

20 mL 10X Running 
Buffer with EDTA

200 mL total

Instrument doorIMPORTANT! Wear gloves when you 
handle the reservoir.

Tray button

Status 
lights

Aqueous 
Waste
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6. Rinse each reservoir using deionized water.

7. Dry the reservoirs using lint-free wipes.
DI H2O ≤ 40 °C
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8. Fill and assemble the reservoirs.

9. To prevent damage to the capillary array, inspect 
each reservoir assembly and verify that the:

• Septa fits snugly and flush on the reservoir 
cap

• Rubber gasket around the edge of the 
reservoir cap is seated correctly

• Holes of the plate retainer and the septa strip 
are aligned

10. Dry the reservoirs using lint-free wipes.

Buffer Reservoir Assembly Water and Waste Reservoir Assemblies

1. Add 80 mL 1X run buffer to the Buffer reservoir.

2. Assemble the reservoir assembly as shown below: 

1. Add 80 mL high-quality deionized water to each
reservoir (Water and Waste).

2. Assemble each reservoir assembly as shown below: 

GR2210

Retainer

Septa

Reservoir cap

Reservoir

Heated plate base

Power cable

Retainer

Septa

Reservoir cap

Reservoir

Plate base

Rubber gasket 
not seated 
correctly

Plate retainer holes 
and septa holes are 
not aligned

Lint-free wipe
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Placing Reservoirs into the Instrument
1. Connect the Buffer reservoir plate base cable 

into the heater outlet within the instrument.

2. Move the buffer reservoir to the Buffer position 
(left).

3. Place the Water and Waste reservoirs into the 
instrument. The reservoirs must be in the 
following order from left to right:

a. Buffer reservoir 
b. Water reservoir 
c. Waste reservoir 

4. Close the instrument door.

5. Press the tray button to return the autosampler to 
the array position.

Heater outlet

Plate base cable

Buffer position

Buffer reservoirIMPORTANT! After placing the buffer reservoir, 
make sure the cable is out of the way of the 
autosampler.

3a 3b 3c

Instrument door

Tray button
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Filling the Anode Buffer Jar

Change the anode buffer:

• Before each group of scheduled runs, or at least 
every 24 to 48 hours

• Every time you fill the polymer block with new 
polymer 

• Every time you change the buffer reservoir

1. Remove the anode buffer jar by pulling down 
while twisting slowly.

2. Empty the anode buffer jar into an aqueous waste 
container.

3. Rinse the anode buffer jar using deionized water.

4. Rinse the anode buffer jar using 1X run buffer:
a. Add 5 mL 1X run buffer to the anode buffer 

jar.

b. Tilt the anode buffer jar 90°.

c. Rotate the jar to rinse the interior with 
buffer.

d. Empty the anode buffer jar into an aqueous 
waste container.

5. Add 67 mL 1X run buffer to the jar.

IMPORTANT! Wear gloves when you 
handle the anode buffer jar.

G
R
23
48

Aqueous 
Waste

G
R

23
44

G
R
23
46

G
R
23
48

90°

Aqueous 
Waste

4b

4c

4d
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6. Put the anode buffer jar on the instrument with 
the overflow hole facing you. 

7. Verify that the electrode is immersed in the 
buffer.

8. If the reservoir fills completely as polymer is 
added, perform steps 1 through 7 of this 
procedure to discard and replace the running 
buffer. 

Note: The meniscus should line up just under 
the red fill line when installed on the instrument.

Electrode

Meniscus

Note: Replace buffer if excess polymer is 
expelled into the anode jar.
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Performing Spatial Calibration

Workflow

Performing
Spatial Calibration

Perform spatial calibration

Evaluate the
calibration data

Performing
Spectral Calibration
for Sequencing and
Fragment Analysis

Setting Up
the Software for
DNA Sequencing

Setting Up
the Software for
Fragment Analysis

Running
the Instrument

Performing
Maintenance

Audit Trails
and Access Control

Preparing the
Instrument

See page 20

See page 22
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Overview

What a Spatial Calibration Tells You 

The 3730/3730xl Data Collection Software uses 
images collected during spatial calibration to establish 
a relationship between the signal emitted by each 
capillary and the position where that signal falls and is 
detected by the CCD camera.

When to Perform the Spatial Calibration

Perform a spatial calibration after you:

• Install a new or used capillary array
• Remove the capillary array from the detection 

cell block (even to adjust it)
• Move the instrument (even if the instrument was 

moved on a table with wheels)

Performing Spatial Calibration
1. In the Tree pane of the Data Collection Software, 

double-click GA Instruments > ga3730 > 
instrument name > Spatial Run Scheduler.

2. In the Spatial Run Scheduler view, do one of the 
following:

• If the capillaries contain fresh polymer, 
select Protocol > SpatialNoFill.

• Otherwise, select Protocol > SpatialFill. 

Spatial Run Scheduler

Select

Note: You do not need to fill the capillaries each 
time you perform a spatial calibration.
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3. Click . 
The approximate calibration run times are:

• 48-cap/36cm array with fill, 4 minutes.
• 96-cap/36cm array with fill, 3 minutes.
• No fill, 2 minutes.

4. Evaluate the calibration as explained on page 22.

Spatial Run Scheduler
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Evaluating the Calibration Data 

1. Verify that the peaks of the spatial are 
approximately the same height.
Are the peaks in the profile approximately the 
same height?
Yes – Go to step 2 on page 22.

No – How does the peak height vary? 
• If the peak height increases at the beginning 

and the end of the spatial profile, then the 
variation in peak height is acceptable. 
Go to step 2 on page 22.

Irregular – If the peak heights are irregular, go to 
“If the Calibration Fails” on page 25.

2. Verify that an orange cross appears at the top of 
each peak in the profile.
Does a cross appear at the top of each peak?
Yes – Go to step 3.
No – Where in the profile is the peak located?

Note: Examples of passing spatial calibration profiles start on page 27.

Magnifying the Spatial Profile

a. Click and drag the cursor to create a box around the 
area of interest.

b. Release the mouse button. 

The data collection software displays the selected 
region.

c. Press R to reset the view.
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• Left side of the profile
If using a 96-capillary array, a small peak 
may appear in the left side of the profile. 
The peak is normal, go to step 3.

• After the first peak
The data collection software did not locate 
the peak correctly. 
Move an orange cross to cover the peak. 
See, “To move an orange cross:” on 
page 24.

3. Check the profile for irregular peaks.
Does the profile contain any irregular peaks?
Yes – The calibration run has failed. Go to “If the 
Calibration Fails” on page 25.
No – Go to step 4.

4. Examine each row of the 96 Capillary Position 
table. Typical values for the Left spacing and 
Right spacing columns are:

• 4 to 8 pixels for a 96-capillary array
• 9 to 11 pixels for a 48-capillary array

Note: Values greater than those stated above are 
acceptable if you are able to see a corresponding 
gap in the capillaries in the detection cell.

Be sure to account for all capillaries (e.g., 96 
capillary positions for 96 capillary array).
– If not, verify that all peaks have crosses. If 

each peak does not each have a cross, see the 
Troubleshooting table below.

– If yes, go to step 5.

Peak does not contain an 
orange cross

Elements of a poor spatial

Left spacing and Right spacing
columns
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5. Accept or reject the spatial calibration as 
follows:
If the calibration:

• Passed, click  writes the 
calibration data to the database.

• Failed, click , then go to “If the 
Calibration Fails” on page 25.

Accept and
Reject buttons

Troubleshooting

Peak does not contain an orange cross.

To move an orange cross: 

1. Magnify the view of the peak without a cross.

2. Determine the peak pixel position.

3. Change the value for the incorrectly positioned cross. 

4. Click outside of that box.

Note: The cross positions cannot be altered after you 
have accepted the calibration data.

Change the cross position
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Troubleshooting

If the Calibration Fails 

If the calibration failed, or if you do not like the appearance of the profile, try one or more of the following actions:

CHEMICAL HAZARD. Methanol 
is a flammable liquid and vapor. Exposure causes eye 
and skin irritation, and may cause central nervous 
system depression and nerve damage. Read the MSDS, 
and follow the handling instructions. Wear appropriate 
protective eyewear, clothing, and gloves. 

1. Go to step 1 on page 20 and repeat the spatial 
calibration.

2. If the calibration fails again:
a. Follow the Bubble Remove wizard to remove 

bubbles and to fill the capillaries with polymer.
b. Go to step 1 on page 20 to repeat the spatial 

calibration.

3. If the calibration fails again:
a. Open the Instrument door.
b. Open the oven door.
c. Open the detection cell door and turn the cam 

knob 1/4 turn clockwise (pointer left).

d. Pull the pump and lower polymer blocks forward 
until the detection cell comes out of the detection 
block.

e. Remove from the pump block:
– Tip of the capillary array
– Array knob
– Ferrule

f. Add one drop of methanol to a sterile swab or lint-
free wipe and apply to the front surface of the 
detection cell.

g. Gently clean the front surface of the detection cell 
using the sterile swab or lint-free wipe.

h. Replace the tip of the capillary array, array knob, 
and ferrule into the pump block.

i. Push the pump and lower polymer blocks back 
against the pump panel, making sure that the 
buffer valve lever properly engages the buffer pin 
valve.

j. Carefully place the detection cell into the 
detection block and secure it by rotating the cam 
knob 1/4 turn counterclockwise (pointer down).

k. Close the detection cell door.
l. Close the oven door.
m. Close the Instrument door.
n. Using the Bubble Remove wizard, remove all 

bubbles. Pay particular attention to the array port 
area.

o. Go to step 1 on page 20 to repeat the calibration.

GR2193

Front surface of the 
detection cell
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4. If the calibration fails again:
a. Perform steps 3a through 3c.
b. Reposition the capillary array window in the 

detection cell.
c. Perform steps 3j through 3m.
d. Go to step 1 on page 20 to repeat the calibration.

5. If calibration fails again, replace the capillary array as 
explained in “Installing the Capillary Array” on 
page 9.

Troubleshooting
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Examples of Passing Spatial Profiles

IMPORTANT! Improper peak identification may lead to sample mistracking on the instrument, and potential 
sample misnaming.

Passing Profile #1

This example shows a typical 
passing profile.

Passing Profile #2

Background artifact

This example shows a passing profile 
with high artifactual background at the 
left margin.

Passing Profile #3
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Performing Spectral Calibration For
Sequencing and Fragment Analysis

Workflow

Performing
Spectral Calibration
for Sequencing and
Fragment Analysis

Prepare the 
spectral calibration

chemistry

Create a spectral
instrument protocol

Perform
spectral calibration

Evaluate the
spectral calibration data

Performing
Spatial Calibration

Preparing the
Instrument

Setting Up
the Software for
DNA Sequencing

Setting Up
the Software for
Fragment Analysis

Running
the Instrument

Performing
Maintenance

Audit Trails
and Access Control

See page 45

See page 42

See page 36

See page 32
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Overview
A spectral calibration creates a matrix that is used during a run to reduce raw data from 
the instrument to the 4- or 5-dye data stored in the sample files. Performing a spectral 
calibration is similar to performing a sample run, except that calibration standards are 
run in place of samples, and a spectral calibration module is used in place of a run 
module.

Spectral calibrations are performed with a specific combination of:

• Dye set (G5, G5-RCT, Any4Dye, Any5Dye, E or Z). For further information see,  
“Preparing the Spectral Calibration Chemistry” on page 32 and, Appendix B, G5, 
G5-RCT, Any4Dye, and Any5Dye Dye Sets.

• Array type (48-capillary or 96-capillary)
• Array length (36-cm or 50-cm)

When to Perform
the Calibration

Perform a spectral calibration:

• Whenever you use a new dye set on the instrument
• After the laser or CCD camera has been realigned/replaced by a service engineer
• If you see a decrease in spectral separation (pull-up and/or pull-down peaks)
• If you alter any condition (dye set, array type, or array length)

Changing
Capillary Array

Lengths

For each dye set, a single spectral calibration can not be used for all capillary array 
lengths. 

• For every sequencing dye set, you must create a separate spectral calibration for 
each capillary array length and array type.

• For every fragment analysis dye set, you must create a separate spectral calibration 
for each capillary array length and array type.

Refer to page 53 for information on how to switch calibrations.

IMPORTANT! Do not run your computer operating systems’ Internet Connection Wizard 
during a spectral calibration.

Note: A spectral calibration algorithm checks dye order.  The error message if the 
algorithm determines that the dyes are in the incorrect order is, "failed calibration due to 
bad data: Bad dye order detected."

IMPORTANT! Spectrals must be calibrated for dye set, array type, and array length.
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Required
Materials

Part numbers are located in Appendix A.

Two Types of
Calibration
Standards

Two types of calibration standards are used to create a matrix:

For Fragment Analysis:

• Matrix standards – four or five fragments of varying size are individually labeled 
with one of the four or five dyes of a set.

For Sequencing:

• Sequencing Standards – standard sequencing reaction fragments of varying size are 
individually labeled with one of the four dyes.

Use the tables below to determine the correct dye set and calibration standard for the 
application you are using.

.

Description

ABI PRISM® BigDye® Terminator v3.1 or v1.1 Sequencing Standard or, DS-33 
Matrix Standard

ABI PRISM® 384- or 96-Well Reaction Plate w/ Barcode 

Multichannel pipettor

Plate retainer

• Plate septum with black plate base 

or,

• Heat-seal with gray plate base

Hi-Di™ formamide

Heated block or thermal cycler

Container with ice

Centrifuge with microplate adapter

Microcentrifuge

Vortex

Gloves

Sequencing Chemistry Dye Set Calibration Standards 

ABI PRISM® BigDye® v3.1Terminator Z_BigDyeV3 BigDye® v3.1 Terminator Sequencing Standard

ABI PRISM® BigDye® v1.1 Terminator E_BigDyeV1 BigDye® v1.1 Terminator Sequencing Standard

Fragment Analysis Chemistry Dye Set Calibration Standards

ABI PRISM® Linkage Mapping Set v2.5/custom oligos G5 DS-33

ABI PRISM® Linkage Mapping Set v2.5/custom oligos G5-RCT DS-33
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Preparing the Spectral Calibration Chemistry
 

1. Dilute spectral calibration standard with Hi-Di™ 
formamide according to the insert instructions.

2. Vortex thoroughly.

3. Briefly centrifuge the mixture.

4. Heat the standard tube at 95 °C for 5 minutes to 
denature the DNA. 

5. Cool the tubes on ice for 2 minutes.

6. Vortex thoroughly and then briefly centrifuge the 
mixture.

CHEMICAL HAZARD. 
Formamide causes eye, skin, and respiratory tract 
irritation. It is a possible reproductive and birth defect 
hazard. Read the MSDS, and follow the handling 
instructions. Wear appropriate protective eyewear, 
clothing, and gloves.

BigDye® Terminator v3.1 or 
v1.1 Sequencing Standard 
or, for fragment analysis, 
DS-33 matrix standard

Denatured standard

Prepared standard

Dilute with Hi-Di 
formamide

00:00:05

Vortex

00:00:05

<1500×g

00:02:00

95 °C

00:02:00

− 4 °C
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Sealing and Preparing the Plate 
Assemblies

1. Add the denatured standard to the wells of a 384- 
or 96-well reaction plate:
If using a:

• 48-capillary, 96-well plate – Add 10 µL of 
denatured standard to each well.

• 384-well plate – Add 5 µL of denatured 
standard into alternating wells of the plate. 
See “Default Load Maps” on page 125

2. Seal the plate with septum or heat-seal:
With septum:

a. Place the plate on a clean, level surface.
b. Lay the septum flat on the plate.
c. Align the holes in the septum strip with the 

wells of the plate, then firmly press 
downward onto the plate.

96-Well
plate

Add 10 µL prepared standard 
to each well

Add 5 µL prepared standard 
into alternating wells (wells A1, 

C1, E1, …)

384-Well
plate

WARNING Do 
not use warped or damaged plates.

Sample plate
(384- or 96-well)

Plate septum
(384- or 96-well)
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d. Ensure that:

• The septa lie flat against the plate. You 
should not feel any lumps or raised edges.

• The septa are inserted straight into the 
wells. You should not see any bent or 
crooked duckbills when viewing the plate 
from above. 

With heat-seal:

a. Follow your thermal sealer instrument 
instructions.

3. Briefly centrifuge the plate.

4. Remove the plate from the centrifuge and verify 
that each sample is positioned correctly in the 
bottom of its well.
If the reagents of any well contain bubbles or are 
not located at the bottom of the well, repeat 
steps 3 and 4.

Septum and 
well not aligned

Septum and 
well not aligned

Septum and 
well aligned

Septum and 
well not aligned

0:05<1500 × g

Prepared standard

Sample is at the 
bottom of the well
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5. Assemble the plate assembly as shown below.

6. Verify that the holes of the plate retainer and the 
septa are aligned.

G
R

21
98

G
R

21
94

Plate retainer

Septum-sealed
sample plate

Black
plate base

Plate septum

Assembled
components

Plate 
retainer

G
R

21
99

Heat-
sealed 
sample 
plate 

Gray plate 
base   

Assembled 
components

Use only black plate bases 
with septa-sealed plates.

Use only gray plate bases 
with heat-sealed plates.

Septum Assembly Heat-sealed Assembly

IMPORTANT! The plate may damage the array if 
the retainer and the septum holes are not aligned.

IMPORTANT! Heat Seal Recommendations

• Use 3-mil Applied Biosystems heat seal film (PN 4337570). This film is 3-mil before, and 1-mil after, 
heating.

• Do not use heat seal film thicker than 1-mil, after heating, on 3730/3730xl DNA Analyzer.
• Do not use heat-seal film containing adhesives or metals as these may damage the instrument’s piercing 

needles.
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Creating a Spectral Instrument Protocol

1. In the Tree pane of the Data Collection Software, 
click GA Instruments > ga3730 > 

Protocol Manager. 

2. In the Instruments Protocols pane, click . 
The Protocol Editor dialog box opens.

3. Select Spectral from the Run Module drop-list.

Create instrument 
protocols here

Create analysis 
protocols here
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4. The Protocol Editor now displays additional 
drop-lists.Select from the following:
If you are using a matrix standard for spectral 
calibration, choose:

a. Run Module: Spect36_MtxStd_1
b. Array Length: 36
c. Chemistry: matrixStandard 

If you are using a sequencing standard for 
spectral calibration you may choose 36-cm or 
50-cm array length:
36-cm capillary array:

a. Run module: Spect36_SeqStd_1
b. Chemistry: sequenceStandard

50-cm capillary array:
a. Run module: Spect50_SeqStd 
b. Chemistry: sequenceStandard

  

IMPORTANT! Select the appropriate capillary 
array length. The array length must match the 
array length information from the Install Array 
wizard.

Note: The Chemistry file for fragment analysis 
dye sets automatically defaults to the Matrix 
Standard.

IMPORTANT! Select the appropriate capillary 
array lengths. The array length must match the 
array length information from the Install Array 
wizard. 

Dye Set  Standard Type Chemistry File

Z_BigDyeV3 BigDye® v3.1 Terminator Sequencing Standard Sequence Standard

E_BigDyeV1 BigDye® v1.1 Terminator Sequencing Standard Sequence Standard
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5. (Optional) Click Edit Param to display the 
Spectral Params dialog box.
Use this dialog box to edit the selection criteria 
for passing or failing spectral calibrations.

Dye Set Matrix Standard Set Chemistry File

G5 DS-33 Matrix Standard

G5-RCT DS-33 Matrix Standard

IMPORTANT! Failure to select the correct chemistry file for the spectral calibration samples you are using results 
in a failing spectral run.

Parameters Valid Data Ranges*

Matrix Condition Number Bounds Lower: 1-10                  Upper: 3-20

Locate Start Point After Scan: 100-5000    Before Scan: 100-5000

Limit Analysis (scans) 400-20,000

Sensitivity 0-0.9

Minimum Quality Score .80-.99

*These ranges are dye-set independent

IMPORTANT! Default parameter values are optimized and are recommended for 
most situations 
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Creating a Spectral Calibration Plate Record
1. In the Tree pane of the Data Collection Software, 

double-click 
GA Instruments > ga3730 > 
instrument name > Plate Manager.

2. Click New to create a new plate.

3. Complete the New Plate dialog box:
a. Enter ID or Barcode number
b. Enter a name for the plate.
c. Optional: Enter a description for the plate 

record.
d. In the Application drop-list, select Spectral 

Calibration. 
e. In the Plate Type drop-list, select 96-Well or 

384-Well.
f. Enter desired scheduling. For more 

information see, “Globally Modifying a 
Run Schedule” on page 122.

4a

4b

4c

4d
4e

4f

4j

4g

4h
4i
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g. In the Plate Sealing drop-list, select Septa 
or Heat Seal.

h. Enter a name for the owner.
i. Enter a name for the operator.
j. Click .

4. In the Spectral Calibration Plate Editor dialog 
box, enter the following information:

a. In the Sample Name column of row A01, 
enter a sample name, then click the next 
cell.

b. In the Comments column of row A01, enter 
any additional comments or notations for 
the sample at the corresponding position of 
the plate.

c. In the Instrument Protocol 1 column of 
row A01, select a protocol from the drop-
list.

5. Highlight the entire row.

6. Select Edit > Fill Down Special.
Based on the plate type (96- or 384-well) and 
capillary array (48 or 96 capillaries) you are 
using, select the appropriate fill down option:
– 96 capillary/96-well plate: Fill Down

– 48 capillary/96-well plate: Fill down Special 
(48 Cap)

– 96 capillary/384-well plate: Fill down Special 
(96 Cap)

– 48 capillary/384-well plate: Fill down Special 
(48 Cap)

7. Click . 
You have successfully created a plate record for 
the spectral calibration plate.

5a 5b 5c

Note: This example assumes that you are 
loading the first quadrant.
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Loading the Plate into the Instrument

1. The name of the plate you just created is 
displayed in the Input Stack window of the Data 
Collection software, and is ready to run.

2. Open the stacker drawer.

3. Open the In Stack tower door. 

4. Place the plate assembly into the stacker. 

5. Close the In Stack tower door.

6. Close the Stacker drawer.

Stacker drawer

Notched corner of the
plate assembly

IMPORTANT! When placing the plate into the 
stacker, the plate must be oriented so that the 
notched corner of the plate assembly is located in 
the rear-right corner of the stacker.

In Stacker tower door
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Running the Spectral Calibration Plate
.1. In the Tree pane of the Data Collection Software, 

double-click 
GA Instruments > ga3730 > 
instrument name > Run Scheduler.

2. In the Run Scheduler view: 
a. In the Add Plate field, scan the barcode of a 

plate to add it to the input stack.

Or,
b. Type the plate ID and press Enter to add it 

to the input stack.  

3. In the toolbar of the Data Collection Software 
window, click  to begin the run.

4. The Processing Plates dialog box opens, then 
click .

5. When the run is finished, remove the plate from 
the instrument.

A9009DR5

Note: The instrument may pause before running 
the plate to raise the oven temperature.

Application Capillary  Array Length (cm) Approximate  Spectral Run Timea (min)

Sequencing 50 120

Sequencing 36 60

Fragment Analysis 36 32

a.  The data collection software may take up to 30 min to calculate the matrices after the run.
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Viewing the Pass/Fail Status After the Run

After the instrument completes the spectral calibration 
run, the pass or fail status of each capillary is recorded 
in the Events Messages section of the Instrument 
Status window.

1. In the Tree pane of the Data Collection Software, 
click GA Instruments > ga3730 > 

instrument 
name > Instrument Status > Event Log.
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2. In the Events Messages section of the window, 
view the status of each capillary.

Dye set G5 status results

For a good-quality calibration, each capillary 
should have a:

• Q-value:
– above 0.95 for matrix standards
– above 0.93 for sequence standards

• Condition number within range of: 

Cap # Pass/fail status Q-value

Condition number

Dye Set Default Condition 
Number Range

Sequencing Analysis

Z_BigDyeV3 2.5 to 4.5

E_BigDyeV1 3.0 to 5

Fragment Analysis

G5 9.5 to 14.5

G5-RCT 9.5 to 14.5
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Evaluating the Spectral Calibration Data

1. In the Tree pane of the Data Collection Software, 
click GA Instruments > ga3730 > 

instrument name > Spectral Viewer.

IMPORTANT! Review and evaluate the spectral calibration profile for each capillary, even if the Spectral 
Calibration Results box indicated that they all passed. 

Note: Pages 49 and 50 contain examples of passing sequencing spectral calibration profiles, and page 51  
contains an example of a passing fragment analysis spectral calibration profile. 

Spectral 
profile

Rename or 
set the active 
spectral 
calibration 
here

Raw data 
(matrix 
standards)

Plate diagram
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2. In the Dye Set drop-list, select the dye set you 
just created.

3. Select a well on the plate diagram to view the 
spectral results of associated capillary.

4. Evaluate the spectral calibration profile for the 
selected capillary:

a. Verify that the order of the peaks in the 
spectral profile from left to right are:
– 4-dye: blue-green-yellow-red
– 5-dye: blue-green-yellow-red-orange
Do the peaks in the profile appear in the 
correct order?
Yes: Go to step c.
No: The calibration run has failed. Go to 
page 55.

Well A1

Passed (dark green)

Selected (light green)

Borrowed/Failed (tan)*

Capillary status:

Selected well

* Overridden capillaries are also 
tan, even if they originally passed.

Blue Green Yellow Red

Example of a 4-dye spectral calibration profile

Blue Green Yellow Red Orange

Example of a 5-dye spectral calibration profile

Blue
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b. Verify that the peaks in the spectral profile 
do not contain gross overlaps, dips, or other 
irregularities (see “Tip: Magnifying the 
Spectral Profile” on page 48).
Are the peaks in the spectral profile separate 
and distinct?
Yes – The capillary has passed. Go to 
step 5.
No – The calibration run has failed. Go to 
page 55.

c. Verify that the order of the peaks in the raw 
data profile from left to right are:
Fragment Analysis

– 5-dye: orange-red-yellow-green-blue
Are the peaks in the wrong order or are 
there any extraneous peaks that adversely 
affect the spectral profile?
Yes: The calibration run has failed. Go to 
page 55.
No: Go to step 5.

5. Repeat steps 3 and 4 for each capillary in the 
array.

Dip

Example of a 4-dye sequencing raw data profile

Example of a 5-dye fragment analysis raw data profile

Left to right: Orange, Red, Yellow, Green, Blue

Peak is distinct and
regular
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6. Rename the spectral run. The spectral file default 
name is the day, date and time of the run.

a. Click .
b. In the Rename Calibration dialog box, enter 

a descriptive name for the spectral 
calibration including the dye set, array 
length and polymer type (optional).

c. Click .

Tip: Magnifying the Spectral Profile

1. In the Tree pane of the Data Collection 
Software, click 

GA Instruments > ga3730 > 
instrument name > Spectral 

Viewer.

2. In the profile or raw data display, click - 
drag the cursor to create a box around 
the area of interest.

Selecting an area to magnify in a spectral profile

3. Release the mouse button. 

The data collection software displays the 
selected region.

4. Press R to reset the view.

Magnified area of that spectral profile
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Examples of Passing Sequencing Spectral Calibrations

Dye Set Z Created from a Sequencing Standard
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Dye Set E Created from a Sequencing 
Standard
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Example of a Passing Fragment Analysis Spectral 
Calibration

Dye Set G5 Created from Matrix Standard 
Set DS-33
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Spectral Viewer

Selecting Active Spectral Calibrations

For best quality data, we suggest that you perform 
spectral calibrations every time a new array is 
installed in the instrument. However, you may  choose 
to reuse previous spectral calibrations to apply to new 
data that will be generated on the instrument. Once 
data is collected, you cannot reapply a different 
spectral calibration. 

When a new spatial calibration is saved, the current 
spectral calibration for DyeSet G5-RCT is 
deactivated. Dye sets G5, E, and Z are not 
deactivated. If you wish to continue without a spectral 
recalibration, you may “Set” an active spectral using 
the instructions below.

All calibrations for your current dye set are listed in 
the List of Calibrations drop-list. Therefore, you can 
choose a spectral to use from that list prior to the 
beginning of a new run.

IMPORTANT! It is essential that you perform a spectral calibration any time the capillary array is moved or 
replaced when using DyeSetG5-RCT.

IMPORTANT! If you installed an array that is a different length or type (48 vs 96) than you were using previously 
and if a previous spectral calibration for the new array/new conditions exits, you must reset the active spectral 
calibration. if a previous spectral for those array conditions exist. Otherwise, you must run a new spectral 
calibration.

Poor quality data or failed analyses are results of using the wrong spectral calibration.

IMPORTANT! Spectrals must be calibrated for dye set, array type, and array length.

Note: An asterisk * precedes failing calibrations.

Note: The most recent spectral for each dye set is automatically chosen as the active calibration. 

Each dye set can have its own active calibration. Thus, there is no need to manually set the active calibration if you 
are performing runs with various dye sets.
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To select a previous spectral calibration:

1. Select the dye set of interest.

2. In the Spectral Viewer, click the List of 
Calibrations drop-menu in the lower, right pane.

3. Select the spectral calibration you want to use for 
future runs.

4. Click Set to display your chosen spectral 
calibration in the Active Calibration text box.

Current calibration

Drop-list of previous 
calibrations for the 
current dye set
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5. (Optional) Click Rename to display the Rename 
Calibration dialog box, enter a new name, and 
click OK.
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Troubleshooting

Troubleshooting spectral calibration

Observation Possible Cause Recommended Action

No signal. Incorrect sample preparation. Replace samples with fresh samples 
prepared with fresh Hi-Di™ 
formamide.

CHEMICAL HAZARD. 
Formamide causes eye, skin, and 
respiratory tract irritation. It is a 
possible reproductive and birth defect 
hazard. Read the MSDS, and follow 
the handling instructions. Wear 
appropriate protective eyewear, 
clothing, and gloves.

Air bubbles in sample tray. Centrifuge samples to remove air 
bubbles.

If the spectral calibration fails, or if a 
message displays “No candidate 
spectral files found.”

Clogged capillary. Refill the capillaries using manual 
control. Look for clogged capillaries 
during capillary fill on the cathode side.

Insufficient filling of array. Check for broken capillaries and refill 
the capillary array.

Expired spectral standards. Check the expiration date and storage 
conditions of the spectral standards. If 
necessary, replace with a fresh lot.

Spikes in the data. Expired polymer. Replace the polymer with a fresh lot 
using the Change Polymer Wizard.

CHEMICAL HAZARD. 
POP-7 polymer cause eye, skin, and 
respiratory tract irritation. Read the 
MSDS, and follow the handling 
instructions. Wear appropriate 
protective eyewear, clothing, and 
gloves.

Air bubbles, especially in the polymer. • Refill the capillaries using the 
Bubble Remove wizard.

• Properly bring the polymer to room 
temperature.

• Replace expired polymer.

Possible contaminant in the polymer. Replace the polymer using the Change 
Polymer wizard.

WARNING!
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Setting Up the Software
for DNA Sequencing

Workflow

Create required settings
for automated 

sequencing analysis

Create and complete a
sequencing analysis

plate record

Fill down special

Setting Up
the Software for
DNA Sequencing

Performing
Spatial Calibration

Performing
Spectral Calibration
for Sequencing and
Fragment Analysis

Preparing the
Instrument

Setting Up
the Software for
Fragment Analysis

Running
the Instrument

Performing
Maintenance

Audit Trails
and Access Control

See page 82

See page 79

See page 62
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Plate Records and Sequencing Analysis

Overview A plate record is similar to a sample sheet or an injection list that you may have used 
with other Applied Biosystems instruments. 

Important Notes • A unique name must be assigned to the instrument computer before 3730/3730xl 
Data Collection software is installed. 

• Do not rename the computer once 3730/3730xl Data Collection software has been 
installed. Doing so will cause the 3730/3730xl Data Collection software to 
malfunction. 

File-Naming
Convention

Some alphanumeric characters are not valid for user names or file names. The invalid 
characters are below:

spaces 

\ / : * ? " < > | 

What Plate
Records Contain

Plate records are data tables in the instrument database that store information about the 
plates and the samples they contain. Specifically, a plate record contains the following 
information:

• Plate name, type, and owner
• Position of the sample on the plate (well number)
• Sample name, see page page 74
• Mobility file (in Analysis Protocol), see page page 66
• Comments about the plate and about individual samples
• Name of the run module and Dye set information (run modules specify information 

about how samples are run) (in Instrument Protocol), see page 62
• Name of the Analysis Protocol—Analysis Protocols specify how data is analyzed at 

the end of the run (in Analysis Protocol), see page page 66

When to Create a
Plate Record

A plate record must be created for each plate of samples for the following types of runs: 

• Spectral calibrations
• Sequencing analysis
• SeqScape analysis

IMPORTANT! An error message is displayed if you use any of these characters. You 
must remove the invalid character to continue.

Note: A plate record must be created in advance of the first run. Plate records can be 
created, and plates added to the stacker, while a run is in progress.
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 Sequencing
Analysis Plate

Record

The Plate Editor displays an empty plate record for the selected application that is 
chosen in the New Plate dialog box. The data fields within a given plate record vary 
depending on the selected application. This section describes the data fields that are 
present in a sequencing analysis Plate Record.

The table below and the flow chart on page 59 describes what each file specifies:

Elements of a Sequencing Analysis plate record

Parameters Description See Page

Instrument Protocol Contains everything needed to run the instrument. 62

Analysis Protocol Contains everything needed to analyze sequencing 
data.

66

Results Group Defines the file type, the file name, file save locations, 
analysis software and autoanalysis.

71

Default analysis
protocols

File Save
preferences

Plate Record

Plate Manager

Results Group

Mobility

Bases called
(pure or mixed)

Post classification
(SQVs)

Post analysis
processing
(clear range)

Analysis Protocol

Run module

Dye set

Instrument Protocol

IMPORTANT! In order for data collection and autoanalysis to be successful, each run of 
samples must have an Instrument Protocol, an Analysis Protocol, and a Results Group 
assigned within a plate record.
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Blank Sequencing Analysis plate record

The following table describes the columns inserted in a Plate Record for a sequencing 
analysis run. 

Default is one sample run. To add additional runs, see page 81.

1 2 3 4 5

Column Description

1. Sample Name  Name of the sample

2. Comment Comments about the sample (optional)

3. Results Group Some options:

• New: Opens the Results Group Editor dialog box

• Edit: Opens the Results Group Editor dialog box for the Results Group listed in the cell

• None: Sets the cell to have no selected Results Group

• Select one of the available Results groups from the list

Note: You must have a Results Group selected for each sample entered in the Sample Name 
column.

See, “Results Groups” on page 71.
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4. Instrument Protocol • New: Opens the Protocol Editor dialog box. 

• Edit: Opens the Protocol Editor dialog box for the Instrument Protocol listed in the cell.

• None: Sets the cell to have no selected protocol.

• List of Instrument Protocols: In alpha-numeric order.

Note: You must have an Instrument Protocol selected for each sample entered in the Sample 
Name column.

See, “Creating an Instrument Protocol” on page 62.

5. Analysis Protocol • New: Opens the Analysis Protocol Editor dialog box. 

• Edit: Opens the Analysis Protocol Editor dialog box for the Instrument Protocol listed in the 
cell. 

• None: Sets the cell to have no selected protocol.

• List of Analysis Protocols: In alpha-numeric order 

Note: You must have an Analysis Protocol selected for each sample entered in the Sample 
Name column.

See, “Creating an Analysis Protocol” on page 66.

Column Description
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Creating Required Settings for Automated Sequencing 
Analysis

If the Settings Already Exist

If the appropriate instrument protocol, analysis 
protocol, and results group have been created, proceed 
to “Creating and Completing a Sequencing Analysis 
Plate Record” on page 79. 

Instrument Protocols

An instrument protocol contains all the settings 
necessary to run the instrument. An instrument 
protocol contains the protocol name, type of run, run 
module, and dye set.

Creating an Instrument Protocol

1. In the Tree pane of the Data Collection Software, 
click GA Instruments 
> ga3730 > Protocol Manager.

Create instrument 
protocols here

Create analysis 
protocols here
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2. In the Instruments Protocols section, click 
.

The Protocol Editor opens. 

3. Complete the Protocol Editor:
a. Type a name for the protocol.
b. Type a description for the protocol 

(optional).
c. Select Regular in the Type drop-list.

d. Using the information in the table below, 
select the correct run module for your run. 

Note: To customize a run module, see “Tip: 
Customizing Run Modules” on page 64.  

3a

3b

3c

3d

3e

3b

Run Module Capillary Array 
Length (cm) Sequencing Run 

Approximate Run 

Times* (min)

XLRSeq50_POP7 50 Extra long read 180

LongSeq50_POP7 50 Long read 120

FastSeq50_POP7 50 Fast read 60

StdSeq36_POP7 36 Standard read 60

RapidSeq36_POP7 36 Rapid read 35

* Approximate run times assume oven temperature has reached run temperature
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e. Using the information in the table below, 
select the correct Dye Set for your run.

f. Click .

Dye Set Chemistry

E_BigDyeV1 ABI PRISM® BigDye® v1.1 Terminator 

Z_BigDyeV3 ABI PRISM® BigDye® v3.1 Terminator

Tip: Customizing Run Modules

You can modify default run modules to suit your 
particular needs. 

1. Click GA Instruments > ga3730 > 
instrument name >  Module Manager. 

2. Click .

The Run Module Editor dialog box opens.

3. Complete the Run Module Editor dialog box:

a. Enter a name for your new module.

b. In the Type drop-list, select the type of module 
(Regular, Spatial or Spectral).

c. In the Template drop-list, select a template 
module as a basis for the new module.

Note: You cannot edit a default module installed with 
3730/3730xl Data Collection software.

d. Optional: Enter a description of your new run 
module.

e. Change to the desired module parameters using 
the range for the allowable parameters.

f. Click OK.

3d

3c

3b

3e

3a
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Editable Run Module Parameters

Parameter Name Range Comment

Oven_Temperature 18-70 C Temperature setting for main oven throughout run.

PreRun_Voltage 0-15 kV Pre run voltage setting before sample injection.

PreRun Time 1-1800 sec Prerun voltage time.

Injection_Voltage 0-15 kV Injection voltage setting for sample injection.

Injection_Time 1-90 sec Sample injection time.

First_ReadOut_time 100-16000 
millisec

The interval of time for a data point to be produced.  
First_ReadOut_time should be equal to Second_ReadOut_time.

Second_ReadOut_Time 100-16000 
millisec

The interval of time for a data point to be produced.  
Second_ReadOut_time should be equal to First_ReadOut_time.

Run_Voltage 0-15 kV Final run voltage.

Voltage_Number_Of_Steps 0-100 steps Number of voltage ramp steps to reach Run_Voltage. We 
recommend that you do not change this value unless advised 
otherwise by Applied Biosystems support personnel.

Voltage_Step_Interval 0-180 sec Dwell time at each voltage ramp step.  We recommend that you do 
not change this value unless advised otherwise by Applied 
Biosystems support personnel.

Voltage_Tolerance 0.1-6 kV Maximum allowed voltage variation. We recommend that you do 
not change this value unless advised otherwise by Applied 
Biosystems support personnel. If it goes beyond tolerance and 
shuts off, contact Applied Biosystems tech support.

Current_Stability 0-2000 microA Maximum allowed electrophoresis current variation. Current 
fluctuations above this value will be attributed to air bubbles in 
system and the voltage automatically turned off.  We recommend 
that you do not change this value unless advised otherwise by 
Applied Biosystems support personnel.

Ramp_Delay 1-1800 sec Delay During Voltage Ramp. We recommend that you do not 
change this value unless advised otherwise by Applied Biosystems 
support personnel.

Data_Delay 1-1800 sec Time from the start of separation to the start of sample data 
collection.

Run_Time 300-14000 sec Duration data is collected after Ramp_Delay.
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Analysis Protocols

An analysis protocol contains all the settings 
necessary for analysis and post processing: 

• Protocol name – The name, description of the 
analysis protocol, and the sequence file formats 
to be used

• Basecalling settings – The basecaller, DyeSet 
file, and analysis stop point to be used

• Mixed Bases – Option: to use mixed base 
identification, and if so, define the percent value 
of the second highest to the highest peak

• Clear Range – The clear range to be used based 
on base positions, sample quality values, and/or 
number of ambiguities (Ns) present

Creating an Analysis Protocol

Refer to the Applied Biosystems DNA Sequencing 
Analysis Software v5.1 User Guide (P/N 4346366), 
chapter 8 for more information regarding analysis 
protocols

1. In the Analysis Protocol section of the Protocol 
Manager, click .
If more than one analysis application is installed 
on the data collection computer, the Analysis 
Applications dialog box opens. 

Note: If you created an appropriate analysis protocol 
in the Sequencing Analysis software, you can use it in 
data collection software. 

IMPORTANT! Do not delete an Analysis Protocol 
during a run while it is being used for that run. 
Autoanalysis will not be performed if you do so.
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2. Select Sequencing Analysis, then click .
The Analysis Protocol Editor dialog box opens.

3. In the General tab:
a. Enter a unique name and description for the 

new protocol.
b. Select the appropriate Sequence File 

formats settings.
3a

3b

Option If checked, the software 
creates…

Write .Seq File
check box

a .seq file for printing the 
sequence as text file or for 
using the file in other 
software.

• ABI format is used with 
Applied Biosystems 
software.

• FASTA format is used 
with other software

Write Standard 
Chromatogram 
Format file 
(.scf)

When selected, the 
software creates a .scf file 
that can be used with other 
software. When created, 
the .scf extension is not 
appended to the file name. 

Write Phred 
(.phd.1) File

When selected and the KB 
basecaller is used, the 
software creates a .phd.1 
file that can be used with 
other software.
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4. Select the Basecalling tab.
a. Select the appropriate basecaller and 

DyeSet primer based on the chemistry and 
capillary array length you are using.

b. In the Processed Data pane, select True or 
Flat Profile.

c. If desired, select one or more stop points for 
data analysis. 

d. Select your Threshold Quality option.

5. Select the Mixed Bases tab.

4c

4d

4a

4b

Note:  Sequencing Analysis Software v5.1 
and 3730/3730xl Data Collection software 
filter .mob file choices to match the chosen 
.bcp file.

Option Function

Used to display data as processed traces scaled uniformly so that the average 
height of peaks in the region of strongest signal is about equal to a fixed value. 
The profile of the processed traces will be very similar to that of the raw traces.

Used to display the data as processed traces scaled semi-locally so that the 
average height of peaks in any region is about equal to a fixed value. The profile of 
the processed traces will be flat on an intermediate scale (> about 40 bases).

Note: This option is applied to data that is analyzed with the KB basecaller only. 
If you use the ABI basecaller the profile option reverts to True Profile.

Option Function

When using the KB basecaller, use this option to assign a base to 
every position, as well as the QV.

When using the KB basecaller, use this option to assign Ns to 
bases with QVs less than the set point. The QV will still be 
displayed.

Note: This function is active with the KB 
Basecaller only.
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a. For mixed bases only, select Use Mixed 
Base Identification. 

b. Use the default setting of 25% or change the 
detection level by entering a new value or 
dragging the % line up or down.

6. Select the Clear Range tab.

Select one or more Clear Range methods. If you 
apply multiple methods, the smallest clear range 
results.

7. Click  to save the protocol and close the 
Sequence Analysis Protocol Editor dialog box.

5a

5b

Note: Do not use less than 15% as your 
detection limit.

Note: The clear range is the region of sequence 
that remains after excluding the low-quality or 
error prone sequence at both the 5´ and 3´ ends.

Use with 
KB Basecaller

Use with ABI and 
KB Basecallers

Use with ABI and 
KB Basecallers
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Editing and Deleting Analysis Protocols

Editing an Analysis Protocol

1. In the Analysis Protocols pane in the Analysis 
Protocol Manager, highlight the protocol you 
want to edit.

2.  Click .

3. Make changes in the General, Basecalling, 
Mixed Bases and Clear Range tabs, as 
appropriate.

4. Click  to save the protocol and close the 
Analysis Protocol Editor dialog box.

Deleting an Analysis Protocol

1. In the Analysis Protocols pane in the Analysis 
Protocol Manager, highlight the protocol you 
want to delete.

2. Click .
The Deletion Confirmation dialog box displays.

3. Click .

IMPORTANT! Do not delete an Analysis Protocol 
during a run while it is being used for that run. 
Autoanalysis will not be performed if you do so. Also, 
You must first delete any plate records using the 
Analysis Protocol before you can delete or modify the 
Analysis Protocol for these plate records. 
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Exporting and Importing Analysis 
Protocols

Exporting an Analysis Protocol

1. In the Analysis Protocols pane in the Analysis 
Protocol Manager, highlight the protocol you 
want to export.

2. Click .
The Export Confirmation dialog box displays.

3. Click Save.

Importing an Analysis Protocol

1. In the Analysis Protocols pane in the Analysis 
Protocol Manager, highlight the protocol you 
want to import.

2. Click .
The Export Confirmation dialog box displays.

3. Click Save.

Results Groups

A Results Group is a component within Data 
Collection that organizes samples and certain user 
settings under a single name. It is called a Results 
Group because it is used to analyze, name, sort, and 
deliver samples that result from a run. 

Creating a Results Group 

1. In the Tree pane of the Data Collection Software, 
click GA Instruments > Results Group.

2. Click . 
The Results Group Editor window displays.
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3. Complete the General tab:
a. Type a Results Group Name. The name can 

be used in naming and sorting sample files. 
It must be unique (see page for a list of 
accepted characters).

b. Type a Results Group Owner (optional). 
The owner name can be used in naming and 
sorting sample files.

c. Type a Results Group Comment (optional).

4. Select the Analysis tab, then:
a. Select Sequencing Analysis from the 

Analysis Type drop-list.
b. In the Analysis Actions section, select Do 

Autoanalysis, if you want your data 
automatically analyzed after a run.

3a

3b

3c

4a

4b

Note: Login ID and password are not required 
for Sequencing Analysis software.
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5. Select the Destination tab, then use the default 
destination or define a new location for data 
storage.

a. Click Use Custom Location, then click 
 to navigate to a different save 

location.
b. Click  to test the Location path 

name connection:
– If it passes, this text displays “Path Name 

test successful.”
– If it fails, this text displays “Could not 

make the connection. Please check that 
the Path Name is correct.” Click Browse 
and select a different location.

5a

5b

5c

To use … Then …

default location skip to step 6

custom location complete  step a and 
step b below

Sample File Destinations: 

Locations where sample files are placed during extraction:

• Default Destination, default folder naming: Data / instrument type / instrument name / run folder  (No ProcessedData 
folder)

• Default Destination, custom folder naming:   Data/top custom folder/subfolders, etc.

• Custom Destination, default folder naming:   Destination/instrument type/instrument name/run folder

• Custom Destination, custom folder naming:   Destination/top custom folder/subfolders, etc.
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6. Select the Naming tab.
Use the Naming tab to customize sample file and 
run folder names. 

The elements of the Naming tab are discussed in 
the following sections. 

Sample File Name Format Pane

Follow the procedure below to complete the Sample 
File Name Format pane.

1. Select the Naming tab.

2. Click the Prefix box (optional) to type a prefix 
for the file name. Anything that you type here is 
shown in the Example line (see graphic below). 

3. Click the Name Delimiter list choose the 
symbol that will separate the Format elements in 
the file name (see step 3 below). Only one 
delimiter symbol may be chosen.

Sample 
File Name 
Format pane

Run Folder 
Name 
Format pane

IMPORTANT! Sample name, run folder name, 
and path name, combined, can total no more than 
250 characters. See page page 58 for accepted 
characters.
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4. Click the Format list and then select the 
components that you want in the sample name. 

For example, if a unique identifier is not included 
in the name, a warning message displays. The 
Results Group makes the file name unique. As 
you select the elements for the file name, they are 
reflected in the Example line. 
As you continue to select elements for the file 
name, additional elements display.

The names of the Format elements eventually 
truncate, but the Example field remains visible 
(up to 72 characters).

Note: Generally, all the samples from a single 
run are placed in the same run or results folder, 
so the name of every sample from a single run 
should be different. Most of the Format options 
will not be different between samples, so you 
need to take care to select at least one of the 
options that make the sample names unique 
within a run. 
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5. Click the Suffix box (optional) and type the 
suffix for the file name.
The File Extension field displays the file 
extension generated from the Analysis Type 
specified on the Analysis tab (page page 72). For 
example, Sequencing Analysis produces sample 
files with an .ab1 extension.

Saving a Results Group

Click  from any tab once all the elements 
within the Results Group have been chosen.

Format Elements (Unique Identifiers)

While you may select a minimum of just one Format 
element for the Sample file and Run folder names in 
order to save a Results Group, selecting just the 
minimum may not provide enough information for 
you to identify the file or folder later.

Note: Even if you create a custom run folder location, 
a separate default run folder is generated that contains 
the log file.

Note: If you choose a non-unique file name, the 
software appends numbers (incrementally) before the 
file extension.
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If you choose elements from the Format lists that do not create unique Sample file or 
Run folder names, a warning message displays below the Example line (see next figure).

To remove the warning message and proceed within the Results Group Editor window, 
simply select a Format element that distinguishes one file from another (for example, the 
capillary number is unique while the instrument name is not).

Run Folder/Sub-
Folder Name
Format Pane

Follow the same steps described above for the Sample File Name Format pane 
(page page 74) to specify the run folder name within the run folder.

Importing and
Exporting a

Results Group

Results Groups can be imported from, or exported to, tab-delimited text files. This 
allows easy sharing of identical Results Groups between instruments.

Importing a Results Group

1. In the Tree pane of the Data Collection Software, click 
GA Instruments > Results Group.

2. Click .
A standard File Import dialog box displays.

3. Navigate to the file you want to import.

Note: Import file type is .txt (text).

4. Click .

Exporting a Results Group

1. In the Tree pane of the Data Collection Software, click 
GA Instruments > Results Group.

2. Click the Results Group name to select it.

Warning message

Note:  When you import or duplicate a Results Group, you are asked to type a 
name for the new Results Group and for the analysis application type.
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3. Click .
A standard file export dialog box displays with the chosen Results Group name.

4. Navigate to the location where you want to save the exported file.

5. Click .

Duplicating a Results Group

1. Click the Results Group to select it.

2. Click . 

Note: If there is a name conflict with a Results Group that already exists at the save 
location, the Results groups can be duplicated in order to copy settings into a 
similar Results Group without the risk of user error when copying it manually (see 
procedure below).

Note: When you import or duplicate a Results Group, you are asked to type a name 
for the new Results Group and for the analysis application type.
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Creating and Completing a Sequencing Analysis Plate 
Record
1. In the Tree pane of the Data Collection Software, 

click GA Instruments > ga3730 > 
Plate Manager.

2. Click .
The New Plate Dialog dialog box opens.

3. Complete the information in the New Plate 
Dialog:

a. Type a plate ID or barcode.
b. Type a name for the plate.
c. Type a description for the plate (optional).
d. Select your sequencing application in the 

Application drop-list.
e. Select 96-well or 384-well in the Plate Type 

drop-list.
f. Schedule the plate. For more information, 

see “Scheduling Runs” on page 121.
g. Select heat seal or septa.
h. Type a name for the owner and operator.
i. Click . 

The Sequencing Analysis Plate Editor 
opens.

3c

3d

3e

3f

3h

3b

3g

3i

3a
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Completing a Sequencing Analysis Plate 
Record

1. In the Sample Name column of a row, enter a 
sample name, then click the next cell. The value 
100 automatically display in the Priority column.

2. In the Comments column, enter any additional 
comments or notations for the sample.

3. In the Results Group 1 column, select a group 
from the drop-list (see page 71).

4. In the Instrument Protocol 1 column, select a 
protocol from the drop-list (see page 62).

5. In the Analysis Protocol 1 column, select a 
protocol from the drop-list (see page 66).

Note: Plate records can be imported and exported as 
tab-delimited files (.txt). 

1 2 3

4 5
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6. To complete the rest of the plate record based on 
the samples loaded in your plate, do one of the 
following:

• For the same samples and protocols – 
Highlight the entire row, then select Edit > 
Fill Down Special (see “Fill Down Special” 
on page 82)

• Based on the plate type (96- or 384-well) 
and capillary array (48 or 96 capillaries) you 
are using, select the appropriate fill down 
option:
– 96 capillary/96-well plate: Fill Down.

– 48 capillary/96-well plate: Fill down 
Special (48 Cap).

– 96 capillary/384-well plate: Fill down 
Special (96 Cap).

– 48 capillary/384-well plate: Fill down 
Special (48 Cap).

• For the same samples and protocols – 
Highlight the entire row, then select Edit > 
Fill Down.

• For the different samples and protocols, 
complete the plate editor manually.

7. If you want to do more than one run, then select 
Edit > Add Sample Run.
Additional Results Group, Analysis Protocol, 
and Instrument Protocol columns are added to 
the right end of the plate record.
You can add additional runs by selecting Edit > 
Add Sample Run again.

8. Complete the columns for the additional runs.

9. Click .

IMPORTANT! After clicking OK within the Plate 
Editor, the completed plate record is stored in the 
Plate Manager database. Once in the Plate 
Manager database, the plate record can be 
searched for, edited, exported, or deleted.
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Fill Down Special 
The following table illustrates the Fill Down Special 
feature. 

If You Choose ... Then ...

Fill Down Special (48 Cap) The fill down pattern matches the 48-capillary load pattern.

Fill Down Special (96 Cap) *

* Especially useful for 384-well 
plates

The fill down pattern matches the 96-capillary load pattern.

First Quadrant

Second Quadrant
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Fill Down Special for a 48 Cap/96-well Plate

The Fill Down Special feature allows you to fill the 
plate record based on the load pattern of the capillary 
array that you are using.

To use the fill down special function:

1. In the Plate Manager, double-click the plate of 
interest to display the Plate Editor.

2. Type the sample name and then double-click it to 
highlight the entire row.



Chapter 4 Setting Up the Software for DNA Sequencing
Fill Down Special

84 Applied Biosystems 3730/3730xl DNA Analyzer User Guide

Notes

3. Select Edit > Fill Down Special (48 Cap) to fill 
the first quadrant.

4. Click A02, type the name of sample 2 and 
highlight the entire row.
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5. Select Edit > Fill Down Special (48 Cap) to fill 
the second quadrant.

Fill Down Special for a 96 Cap/384-well Plate

this is how the fill down pattern looks when you use 
the Fill Down Special (96 Cap) feature on a 384-well 
plate.

First 
Quadrant

Second 
Quadrant
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Adding a Sample Run

By adding additional sample runs, you can run samples with different variables 
(different run modules, for example). 

Select Edit > Add Sample Run

Adding an instance opens an additional:

• Results Group
• Instrument Protocol 
• Analysis Protocol (sequencing only)

To run the plate(s), see “Running the Instrument” on page 115.
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Setting Up the Software for
Fragment Analysis

Workflow

Create required settings
for automated

fragment analysis

Create and complete
 a GeneMapper

plate record

Setting Up
the Software for
Fragment Analysis

Performing
Spatial Calibration

Performing
Spectral Calibration
for Sequencing and
Fragment Analysis

Setting Up
the Software for
DNA Sequencing

Preparing the
Instrument

Running
the Instrument

Performing
Maintenance

Audit Trails
and Access Control

See page 108

See page 95
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3730/3730xl Data Collection and GeneMapper Software

Important Note Do not rename the computer once 3730/3730xl Data Collection software has been 
installed. Doing so will cause the 3730/3730xl Data Collection software to malfunction. 

File-Naming
Convention

Some alphanumeric characters are not valid for user names or file names. The invalid 
characters are below:

spaces \ / : * ? " < > | 

Autoanalysis You may choose to perform autoanalysis of fragment analysis samples by utilizing 
features of the 3730/3730xl Data Collection and GeneMapper software.

GeneMapper Software v3.5

Autoanalysis can be performed on the same instrument that collected the sample files or 
on a remote computer.

Manual Analysis For information on manual analysis, refer to GeneMapper Software Version 3.5 User 
Guide (PN 4343790) 

Fragment
Analysis and Data

Collection

When GeneMapper software is installed on a computer that has 3730/3730xl DNA 
Analyzer Data Collection Software, two applications are available through the Results 
Group Editor (see page 102):

• GeneMapper-Generic

and,

• GeneMapper-<Computer Name>

IMPORTANT! An error message is displayed if you use any of these characters. You 
must remove the invalid character to continue.
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GeneMapper-
Generic

GeneMapper-Generic enables you to generate .fsa files, but not perform autoanalysis. 
When completing the Sample Sheet, you need to fill in basic information for Data 
Collection to complete the run; all other GeneMapper software related fields are text 
entries. This is useful if you are using other software applications for analysis. This is 
also useful if you choose to analyze your samples in GeneMapper software on another 
computer, but do not have the same entries in the GeneMapper software database stored 
on the Data Collection computer. For example, if you have a customized size standard 
definition on the other GeneMapper software computer, you can type in that size 
standard name in the size standard text field and it will populate that column in your 
GeneMapper software project.

GeneMapper-
<Computer

Name>

GeneMapper-<Computer Name> is for autoanalysis. The Size Standard, Analysis 
Method, and Panel columns in the Sample Sheet window read directly from the 
GeneMapper software database. These components must be created in GeneMapper 
software prior to setting up the plate record for a run. There is no way to create a new 
entry for these columns once inside the plate editor dialog box. If you create a new 
GeneMapper software component while the plate record dialog box is open, the columns 
will not update. The plate record must be closed and reopened to update the 
GeneMapper software components. For more information see, “Setting Up a Run for 
Autoanalysis” on page 136.
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Workflow for
Autoanalysis

Using
GeneMapper

Software

Register software and 
create user IDs

Create 
Instrument Protocol

Create 
Results Group

Is 
GeneMapper 

registered and have 
user IDs been 

created?

Open 
Autoanalysis Manager

Set up instrument and 
prepare samples

Do
you have an 

Instrument Protocol, 
and Results 

Group?

Search for plate record, 
then schedule run

Start and monitor run

Create and save 
plate record

No

No

Yes

 Create definitions for:
 - Analysis Method
 - Panel
 - Size Standard

Have
you created 

definitions for 
Size Std, Panel, and
Analysis Method in 

GeneMapper
software?

No

Yes

Yes

Autoanalysis Manager 
automatically processes 

the data

Review data in 
GeneMapper software
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GeneMapper Plate Records

Overview A plate record is similar to a sample sheet or an injection list that you may have used 
with other Applied Biosystems instruments. 

Plate records are data tables in the instrument database that store information about the 
plates and the samples they contain. Specifically, a plate record contains the following 
information:

• Plate name, type, and owner
• Position of the sample on the plate (well number)
• Comments about the plate and about individual samples
• Dye set information (in Instrument protocol)
• Name of the run module (run modules specify information about how samples 

are run) (in Instrument protocol)

When to Create a
Plate Record

A plate record must be created for each plate of samples for the following types of runs: 

• Spectral calibrations
• Fragment analysis

IMPORTANT! In order for data collection and auto-analysis to be successful, each run of 
samples must have an Instrument Protocol and a Results Group assigned within a plate 
record.

Note: A plate record must be created in advance of the first run. Plate records can be 
created, and plates added to the stacker, while a run is in progress.

Parameters Description See 
Page

Instrument 
Protocol

Contains everything needed to run the instrument. 97

Results Group Defines the file type, the file name, autoanalysis, and file save 
locations that are linked to sample injections.

102
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Elements of a GeneMapper Software Plate Record

Plate Record

Plate Manager

Analysis method

Bin set

Panel

GeneMapper software 
definitions:

Size standard

SNP Set

Results Group
 Name

Analysis software 
and autoanalysis

Results Group

Instrument 
Protocol Name

Run type 
(Regular)

Instrument Protocol

Run module

Dye set

File storage 
location

File and run folder
name preferences

Data Collection 
software files:
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The following table describes the columns inserted in a Plate Record for a fragment 
analysis run. 

54 73 6 81 2

Default is one sample run. To add additional runs, see page 112.

9 10

Column Description

1.  Sample Name Name of the sample

2.  Comment Comments about the sample (optional)

3.  Sample Type Use to identify the sample as Sample, Positive Control, Allelic 
Ladder or Negative Control.

4.  Size Standard

IMPORTANT!                                                            
For GeneMapper-<Computer Name> ONLY: 

Size Standard, Panel, and Analysis Method must be 
created in GeneMapper software before creating a 
new plate

• GeneMapper-Generic (optional):

Manually enter size standards in the text field

• GeneMapper-<Computer Name>:

Select a saved size standard from the drop-list
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5.  Panel 

IMPORTANT!                                                           For 
GeneMapper-<Computer Name> ONLY: 

Size Standard, Panel, and Analysis Method must be 
created in GeneMapper software before creating a 
new plate

• GeneMapper-Generic (optional):

Manually enter panels in the text field*

• GeneMapper-<Computer Name>:

Select a saved panel from the drop-list

6.  Analysis Method

IMPORTANT!                                                                 
For GeneMapper <Computer Name> ONLY: 

Size Standard, Panel, and Analysis Method must be 
created in GeneMapper software before creating a 
new plate

• GeneMapper-Generic (optional):

Manually enter analysis methods in the text field*

• GeneMapper-<Computer Name>:

Select a saved analysis method from the drop-list

7.  Snp

IMPORTANT!                                                           For 
GeneMapper <Computer Name> ONLY: 

Size Standard, Panel, and Analysis Method must be 
created in GeneMapper software before creating a 
new plate

• GeneMapper-Generic (optional):

Manually enter analysis methods in the text field*

GeneMapper-<Computer Name>:

Use for SNPlex chemistry; select a saved SNP set from the 
drop-list

8.  3 User-defined columns Optional text entries

9. Results Group Some options:

• New: Opens the Results Group Editor dialog box

• Edit: Opens the Results Group Editor dialog box for the Results 
Group listed in the cell

• None: Sets the cell to have no selected Results Group

• Select one of the available Results groups from the list

Note: You must have a Results Group selected for each sample 
entered in the Sample Name column.

See, “Results Groups” on page 102.

10.  Instrument Protocol • New: Opens the Protocol Editor dialog box. 

• Edit: Opens the Protocol Editor dialog box for the Instrument 
Protocol listed in the cell.

• None: Sets the cell to have no selected protocol.

• List of Instrument Protocols: In alpha-numeric order.

Note: You must have an Instrument Protocol selected for each 
sample entered in the Sample Name column.

• See, “Instrument Protocols” on page 97.

Column Description
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Creating Required Settings for Automated Fragment Analysis

If the Settings Already Exist

If the appropriate data collection and fragment 
analysis files have been created, proceed to “Creating 
and Completing a GeneMapper Plate Record” on 
page 110. 

Instrument Protocols

An instrument protocol contains all the settings 
necessary to run the instrument. An instrument 
protocol contains the protocol name, type of run, run 
module, and dye set.

Creating an Instrument Protocol

1. In the Tree pane of the Data Collection Software, 
click GA Instruments > ga3730 > 

Protocol Manager.

Create instrument 
protocols here

Create analysis 
protocols here
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2. In the Instruments Protocols section, click 
. 

The Protocol Editor opens. 

3. Complete the Protocol Editor:
a. Type a name for the protocol.
b. Type a description for the protocol 

(optional).
c. Select Regular in the Type drop-list.

d. Select GeneMapper36_POP7.
e. Select G5.
f. Click .

Importing an Instrument Protocol

1. Click  in the Instrument Protocols pane 
of the Protocol Editor window. 

3a

3b

3c

3d

3e
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2. Navigate to the protocol you want to import.

3. Double-click the protocol to import it.
The imported files are displayed alphabetically 
in the Instrument Protocol pane.

Note: Import file type is .txt (text).
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Customizing Run Modules

You can modify default run modules to suit your 
particular needs. 

1. Click 
GA Instruments > ga3730 > Module 
Manager. 

2. Click .

3. Select a template module as a basis for the new 
module.

4. Change to the desired module parameters using 
the table below as a guide to the allowable 
parameters.

Note: You cannot edit a default module 
installed with 3730/3730xl Data Collection.

Choose module template from the 
drop-down menu (step 3).
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The Run Module Parameters that you can edit:

Parameter Name Range Comment

Oven_Temperature 18-70 C Temperature setting for main oven throughout run.

PreRun_Voltage 0-15 kV Pre run voltage setting before sample injection.

PreRun Time 1-1800 sec Prerun voltage time.

Injection_Voltage 0-15 kV Injection voltage setting for sample injection.

Injection_Time 1-90 sec Sample injection time.

First_ReadOut_time 100-16000 
millisec

The interval of time for a data point to be produced.  
First_ReadOut_time should be equal to 
Second_ReadOut_time.

Second_ReadOut_Time 100-16000 
millisec

The interval of time for a data point to be produced.  
Second_ReadOut_time should be equal to 
First_ReadOut_time.

Run_Voltage 0-15 kV Final run voltage.

Voltage_Number_Of_Steps 0-100 steps Number of voltage ramp steps to reach Run_Voltage. We 
recommend that you do not change this value unless advised 
otherwise by Applied Biosystems support personnel.

Voltage_Step_Interval 0-180 sec Dwell time at each voltage ramp step.  We recommend that 
you do not change this value unless advised otherwise by 
Applied Biosystems support personnel.

Voltage_Tolerance 0.1-6 kV Maximum allowed voltage variation. We recommend that you 
do not change this value unless advised otherwise by Applied 
Biosystems support personnel. If it goes beyond tolerance and 
shuts off, contact Applied Biosystems tech support.

Current_Stability 0-2000 microA Maximum allowed electrophoresis current variation.  Current 
fluctuations above this value will be attributed to air bubbles in 
system and the voltage automatically turned off.  We 
recommend that you do not change this value unless advised 
otherwise by Applied Biosystems support personnel.

Ramp_Delay 1-1800 sec Delay During Voltage Ramp.  We recommend that you do not 
change this value unless advised otherwise by Applied 
Biosystems support personnel.

Data_Delay 1-1800 sec Time from the start of separation to the start of data collection.

Run_Time 300-14000 sec Duration data is collected after Ramp_Delay.
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Results Groups

A Results Group is a component within Data 
Collection that organizes samples and certain user 
settings under a single name. A Results Group is used 
to prepare samples for analysis and, to name, sort, and 
deliver samples that result from a run. 

Creating a Results Group for Autoanalysis

1. In the Tree pane of the Data Collection Software, 
click GA Instruments > Results Group.

2. Click New. 
The Results Group Editor window displays.

3. Complete the General tab:
a. Type a Results Group Name. The name can 

be used in naming and sorting sample files. 
It must be unique (see page for a list of 
accepted characters).

b. Type a Results Group Owner (optional). 
The owner name can be used in naming and 
sorting sample files.

c. Type a Results Group Comment (optional).

3a

3b

3c
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4. Select the Analysis tab, then:
a. Click the Analysis Type and then select one 

of the following:

b. In the Analysis Actions section, use the 
table below to select an option.

c. Type the Login ID.
d. Type the login password.

The login ID and password relate to the 
GeneMapper software UserName and Password. 
These items can only be created through the 
GeneMapper software Options Users tab.

4a

4b

4c

4d

If You Select ... Then ...

None Only raw data files are 
generated

GeneMapper-
Generic

Autoanalysis is not 
available and only .fsa files 
are generated

GeneMapper-
<Computer Name>

• Autoanalysis of 
completed runs is 
available

• Automated Processing 
tab is available

Steps b, c, and d below 
apply only to GeneMapper-
<Computer Name> (not 
GeneMapper-Generic).

If You Select … Then … Use with Setting from Automated 
Processing Tab (page 105)

Do Autoanalysis Samples are analyzed after each run of 
48 or 96 samples.

When every run completes

Do Autoanalysis and 
Results Entry Group 
Complete

Samples are analyzed after all samples 
using the same results group have been 
run.

Only when the result group is complete
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5. Select the Destination tab, then use the default 
destination or define a new location for data 
storage.

a. Click Use Custom Location, then click 
 to navigate to a different save 

location.
b. Click  to test the Location path 

name connection:
– If it passes, this text displays “Path Name 

test successful.”
– If it fails, this text displays “Could not 

make the connection. Please check that 
the Path Name is correct.” Click Browse 
and select a different location.

5a

5b

5c

To use a … Then …

default location skip to step 6

custom location 

Use for remote analysis 
using GeneMapper v3.5

complete step a 
and step b below

Sample File Destinations: 

Locations where sample files are placed during extraction:

• Default Destination, default folder naming: Data / instrument type / instrument name / run folder  (No ProcessedData 
folder)

• Default Destination, custom folder naming:   Data/top custom folder/subfolders, etc.

• Custom Destination, default folder naming:   Destination/instrument type/instrument name/run folder

• Custom Destination, custom folder naming:   Destination/top custom folder/subfolders, etc.
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6. Select the Naming tab.
Use the Naming tab to customize sample file and 
run folder names. 

The elements of the Naming tab are discussed in 
the following sections, see page 106.

7. Select the Automated Processing tab.

In the “Autoanalysis is performed” section, use 
the table below to select when you want your 
samples autoanalyzed.

8. Click  to save the Results Group. 

Sample File Name Format pane

Run Folder Name Format pane

IMPORTANT! Sample name, run folder name, 
and path name, combined, can total no more than 
250 characters. See page 90 for accepted 
characters.

Select an autoanalysis option

Note: The Automated Processing tab is 
available only if you selected GeneMapper-
<Computer Name> in step 4 on page 101

If You Select … Then … Use with Settings from Analysis Tab
(page 101)

Only when the result group 
is complete

Samples are analyzed after all samples 
using the same results group have been 
run.

• Do Autoanalysis 

and 

• Do Autoanalysis and Results Entry 
Group Complete

When every run completes Samples are analyzed after each run of 
48 or 96 samples.

Do Autoanalysis only
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Sample File Name Format Pane

Follow the procedure below to complete the Sample 
File Name Format pane.

1. Click the Prefix box (optional) to type a prefix 
for the file name. Anything that you type here is 
shown in the Example line (see graphic below). 

2. Click the Name Delimiter list choose the 
symbol that will separate the Format elements in 
the file name (see step 3 below). Only one 
delimiter symbol may be chosen.

3. Click the Format list and then select the 
components that you want in the sample name. 

For example, if a unique identifier is not included 
in the name, a warning message displays. The 
Results Group makes the file name unique. As 
you select the elements for the file name, they are 
reflected in the Example line. 

Note: Generally, all the samples from a single 
run are placed in the same run or results folder, 
so the name of every sample from a single run 
should be different. Most of the Format options 
will not be different between samples, so you 
need to take care to select at least one of the 
options that make the sample names unique 
within a run. 
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As you continue to select elements for the file name, additional elements display.

The names of the Format elements eventually truncate, but the Example field 
remains visible (up to 72 characters).

Note: An additional format list drop-menu displays after you select a format option.

Note: To view the truncated format elements, place the cursor on the edge of the 
window until it turns into a double-arrow. Drag the arrow to expand the window 
horizontally. 
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4. Click the Suffix box (optional) and type the suffix for the file name.
The File Extension field displays the file extension generated from the Analysis 
Type specified on the Analysis tab (page 101). For example, fragment analysis 
produces sample files with an .fsa extension.

Run Folder/Sub-Folder Name Format Pane

Follow the same steps described above for the Sample File Name Format pane 
(page 104) to change the sub-folder name within the run folder.

Format Elements (Unique Identifiers)

While you may select a minimum of just one Format element for the Sample file and 
Run folder names in order to save a Results Group, selecting just the minimum may not 
provide enough information for you to identify the file or folder later.

If you choose elements from the Format lists that do not create unique Sample file or 
Run folder names, a warning message displays below the Example line 
(see figure below).

To remove the warning message and proceed within the Results Group Editor window, 
simply select a Format element that distinguishes one file from another (for example, the 
capillary number is unique while the instrument name is not).

Note: If you choose a non-unique file name, the software appends numbers 
(incrementally) before the file extension.

Warning message
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Importing and
Exporting a

Results Group

Results Groups can be imported from, or exported to, tab-delimited text files. This 
allows easy sharing of identical Results Groups between instruments.

Importing a Results Group

1. In the Tree pane of the Data Collection Software, click 
GA Instruments > Results Group.

2. Click .
A standard File Import dialog box displays.

3. Navigate to the file you want to import.

4. Click .

Exporting a Results Group

1. In the Tree pane of the Data Collection Software, click 
GA Instruments > Results Group.

2. Click the Results Group name to select it.

3. Click .
A standard file export dialog box displays with the chosen Results Group name.

4. Navigate to the location where you want to save the exported file.

5. Click .

Duplicating a Results Group

1. Click the Results Group to select it.

2. Click . 

Note: Import file type is .txt (text).

Note:  When you duplicate a Results Group, you are asked to type a name for the 
new Results Group and for the analysis application type.

Note: If there is a name conflict with a Results Group that already exists at the save 
location, the Results groups can be duplicated in order to copy settings into a 
similar Results Group without the risk of user error when copying it manually (see 
procedure below).

Note: When you duplicate a Results Group, you are asked to type a name for the 
new Results Group and for the analysis application type.
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Creating and Completing a GeneMapper Plate Record

Creating the GeneMapper Plate Record for 
Autoanalysis

1. In the Tree pane of the Data Collection Software, 
click GA Instruments > ga3730 > 

Plate Manager.

2. Click .
The New Plate Dialog dialog box opens.

3. Complete the information in the New Plate 
Dialog:

a. Type a plate ID.
b. Type a name for the plate.
c. Type a description for the plate (optional).

d. Select your GeneMapper application in the 
Application drop-list.

e. Select 96-well or 384-well in the Plate Type 
drop-list.

f. Schedule the plate. For more information, 
see “Scheduling Runs” on page 121.

g. Select Heat Sealing or Septa.
h. Type a name for the owner and the operator.
i. Click . 

The GeneMapper Plate Editor opens.

3b

3c

3d

3e

3f

3g

3h

3i

3a
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Completing a GeneMapper Plate Record 
for Autoanalysis

1. In the Sample Name column of a row, enter a 
sample name, then click the next cell. 

2. In the Comment column, enter any additional 
comments or notations for the sample.

3. In the Sample Type column, select a sample type 
from the drop-list. 

4. In the Size Standard column, select a size 
standard from the drop-list.

5. In the Panel column, select a panel from the 
drop-list.

6. In the Analysis Method column, select a method 
from the drop-list.

7. In the Snp Set column, select a SNP set from the 
drop-list.

8. Enter text for User-Defined columns 1 to 3.

9. In the Results Group 1 column, select a group 
from the drop-list.

10. In the Instrument Protocol 1 column, select a 
protocol from the drop-list.

1 2 3

654 7

108 9



Chapter 5 Setting Up the Software for Fragment Analysis
Creating and Completing a GeneMapper Plate Record

110 Applied Biosystems 3730/3730xl DNA Analyzer User Guide

Notes

11. To complete the rest of the plate record based on 
the samples loaded in your plate, do one of the 
following:

• For the same samples and protocols – 
Highlight the entire row, then select Edit > 
Fill Down Special. For more information 
see, “Fill Down Special” on page 111.

• Based on the plate type (96- or 384-well) 
and capillary array (48 or 96 capillaries) you 
are using, select the appropriate fill down 
option:
– 96 capillary/96-well plate: Fill Down

– 48 capillary/96-well plate: Fill down 
Special (48 Cap)

– 96 capillary/384-well plate: Fill down 
Special (96 Cap)

– 48 capillary/384-well plate: Fill down 
Special (48 Cap)

• For the different samples and protocols, 
complete the plate editor manually.

12. If you want to do more than one run, then select 
Edit > Add Sample Run.
Additional Results Group and Instrument 
Protocol columns are added to the right end of 
the plate record.
You can add additional runs by selecting Edit > 
Add Sample Run again (for more information 
see, “Adding a Sample Run” on page 113.

13. Complete the columns for the additional runs.

14. Click  to save, then close the plate record.

IMPORTANT! After clicking OK within the Plate 
Editor, the completed plate record is stored in the 
Plate Manager database. Once in the Plate 
Manager database, the plate record can be 
searched for, edited, exported, or deleted.
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Fill Down Special 
The following table illustrates the Fill Down Special 
feature. 

Fill Down Special for a 48 Cap/96-well Plate

The Fill Down Special feature allows you to fill the 
plate record based on the load pattern of the capillary 
array that you are using.

If You Choose ... Then ...

Fill Down Special 
(48 Cap)

The fill down pattern matches the 48-
capillary load pattern.

Fill Down Special 
(96 Cap) *

* Especially useful for 
384-well plates

The fill down pattern matches the 96-
capillary load pattern.

First Quadrant

Second Quadrant



Chapter 5 Setting Up the Software for Fragment Analysis
Fill Down Special

112 Applied Biosystems 3730/3730xl DNA Analyzer User Guide

Notes

To use the fill down special function:

1. In the Plate Editor, complete the sample 
information in a row within the quadrant you 
want.

2. Highlight the entire row.

3. Select Edit > Fill Down Special (48 Cap) to fill 
the first quadrant.

4. Click A02, type the sample information, and 
highlight the entire row.

5. Select Edit > Fill Down Special (48 Cap) to fill 
the second quadrant.

First 
Quadrant

Second 
Quadrant
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Fill Down Special for a 96 Cap/384-well Plate

This is how the fill down pattern looks when you use 
the Fill Down Special (96 Cap) feature on a 384-well 
plate.

Adding a Sample Run

By adding additional sample runs, you can run 
samples with different variables (different run 
modules, for example). 

Adding a sample run opens an additional:

• Results Group
• Instrument Protocol 

1. Select Edit > Add Sample Run

To Run the plate(s), see “Running the Instrument” on 
page 115.
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Running the Instrument

Workflow

Work with plate assemblies

Place plate assemblies
into the instrument

Schedule a run

Run the instrument

Control the run

View analyzed data

Work with data in the
    Run History view

Running
the Instrument

Performing
Spatial Calibration

Performing
Spectral Calibration
for Sequencing and
Fragment Analysis

Setting Up
the Software for
DNA Sequencing

Setting Up
the Software for
Fragment Analysis

Preparing the
Instrument

Performing
Maintenance

Audit Trails
and Access Control

See page 116

See page 144

See page 143

See page 137

See page 134

See page 121

See page 120
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Working with Plate Assemblies

Plate Assembly
Components

Materials Required for Septa Assemblies

Each 96- or 384-well septa assembly contains a:

• Plate retainer
• Plate septa
• Sample plate
• Base plate

 Do not use warped or damaged plates.

Use only black plate bases with septa-sealed plates.

Sample plate 

Black plate 
base

Plate septa

96-well

Plate retainer
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Materials Required for Heat-sealed Assemblies

Each 96- or 384-well heat-sealed assembly contains a:

• Plate retainer
• Heat seal film
• Sample plate
• Base plate

Use only gray plate bases with heat-sealed plates.

G
R

21
96

Plate 
retainer

G
R

21
99

Heat 
seal film

 sample 
plate 

Gray plate 
base   

Assembled 
components

384-well plate

IMPORTANT! Heat Seal Recommendations

• Use 3-mil Applied Biosystems heat seal film (PN 4337570). This film is 3-mil before, and 1-mil after, 
heating.

• Do not use heat seal film thicker than 1-mil, after heating, on 3730/3730xl DNA Analyzer.
• Do not use heat-seal film containing adhesives or metals as these may damage the instrument’s piercing 

needles
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Preparing a Septa Plate Assembly

1. Seal the plate:

a. Place the plate on a clean, level surface.
b. Lay the septa flat on the plate.
c. Align the holes in the septa strip with the 

wells of the plate, then firmly press 
downward onto the plate.

2. To prevent damage to the capillary array, inspect 
the plate and septa to verify the septa fits snugly 
and flush on the plate.

3. Assemble the plate assembly:
a. Place the sample plate into the plate base. 
b. Snap the plate retainer onto the plate and 

plate base.

Plate septa

Sample plate 

Septa and well 
not aligned

Septa and well 
not aligned

Assembled 
components 

3a
3b
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4. Verify that the holes of the plate retainer and the 
septa strip are aligned. If not, re-assemble the 
plate assembly (see step 3).

Plate retainer 
holes and septa
holes are not 
aligned

IMPORTANT! Damage to the array tips will 
occur if the plate retainer and septa strip holes do 
not align correctly.



Chapter 6 Running the Instrument
Placing Plate Assemblies into the Instrument

120 Applied Biosystems 3730/3730xl DNA Analyzer User Guide

Notes

Placing Plate Assemblies into the Instrument
1. Open the stacker drawer.

2. Open the door of the In Stack tower. 

3. Place the plate assemblies into the stacker in any 
order. 

4. Close the metal In Stack tower door.

5. Close the Stacker drawer.

Stacker drawer

Notched corner
of the plate

assembly

IMPORTANT! When placing the plate into the 
stacker, the plate must be oriented so that the 
notched corner of the plate assembly is located in 
the rear-right corner of the stacker.

IMPORTANT! Do not place more than 16 plates 
in the stacker.

≤ 16 plate assemblies

In Stack tower door
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Scheduling Runs

In the Tree pane of the Data Collection Software, 
click  GA Instruments > ga3730 > 

instrument name > Run Scheduler.
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384-Well Plate Mapping and Default Run 
Scheduling

Samples within a plate run in the order of their well 
designation. For example, a default 384-well injection 
pattern looks like this:

• Plates that contain samples in a single quadrant 
and with more than one instrument protocol 
specified, run all the protocols in the order they 
appear in the plate record before the next 
quadrant is run. 

For information on setting up a Plate record, page 58 
for sequencing, and page 91 for fragment analysis.

The following table lists the default run priorities and 
load positions

Globally Modifying a Run Schedule

You can change the run order of quadrants and then 
apply it to all 384-well plates. 

Quadrant 1: wells A1, C1, E1, G1...

Quadrant 2: wells B1, D1, F1, H1...

Quadrant 3: wells A2, C2, E2, G2...

Quadrant 4: wells B2, D2, F2, H2...

Note: The analysis module of a sample plays no part 
in the order in which that sample quadrant runs.

Number of 
Capillaries Plate Size Run 

Priority Quadrant First Load Position

96 384-well 1

2

3

4

Q1

Q2

Q3

Q4

Well A1

Well B1

Well A2

Well B2

48 96-well 1 Q1, load 1

Q1, load 2

Well A1

Well A2

48 384-well 1

2

3

4

Q1, load 1

Q1, load 2

Q2, load 1

Q2, load 2

Q3, load 1

Q3, load 2

Q4, load 1

Q4, load 2

Well A1

Well A3

Well B1

Well B3

Well A2

Well A4

Well B2

Well B4

Note: When using a 384-well plate and a 48-capillary array, you can change 
the run order of the main quadrant (bold numbers above) but not the load 
numbers.
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To modify the run order for all 384-well plates:

1. Click your instrument name in the left pane.

2. Select Instrument > Scheduling Preference.
The Default 384 well scheduling preference 
dialog box displays.

3. Select the quadrant priority (run order) from the 
Quadrant list.

You may select any run order. The example to 
the right shows a 4-3-2-1 quadrant priority (run 
order). With a 384-well and a 96-capillary array, 
the samples would run in this order:
B2, A2, B1, A1...
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Locally Modifying a Run Schedule

You can also change the run order of quadrants within 
a specific sample plate.

To locally modify the run order within a single     
384-well plate:

1. In the Plate Manager, click New Plate.

Note: For information about the Plate Manager, 
see page 79 for sequencing, and page 108 for 
fragment analysis.

2. Select 384-Well from the Plate Type list.
The Scheduling box is activated.

3. Type the run priority in the Scheduling box.

4. Click OK.

Type run 
priorities here
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Default Load Maps
Refer to the following load maps for different sized arrays and sample plates.

96-Well Plate,
48 Capillaries

Sample Plate: 96-well, Array: 48-capillary

96-Well Plate,
96 Capillaries

Sample Plate: 96-well, Array: 96-capillary
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384-Well Plate, 96
Capillaries

For a 384-well plate, injections are made from every other well and every other row. A 
full 384-well plate requires 4 runs for a 96-capillary array, and 8 runs for 48-capillary 
array, to inject all the samples once.
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Barcode Readers

                                 ELECTRICAL HAZARD. Power off the instrument and the 
computer before connecting an external barcode reader to the instrument.

Internal Barcode
Reader

The 3730 & 3730xl internal barcode reader supports the following formats:

• Code 128
• Code 39
• Code 93
• LOGMARS
• EAN-8

The barcode reader shares the default Windows illegal character list, which means the 
illegal characters for the reader are \ / : * ? " < > | and also having a space is illegal.

External Barcode
Readers

KEYENCE BL-80VE

An external barcode reader can also be used with the 3730 and 3730xl instruments. We 
have experience with the KEYENCE BL-80VE (see photo above), which connects to the 
instrument computer keyboard. With this reader, you can scan barcodes into any text box 
in the Data Collection software. 

Note: All Applied Biosystems barcoded plates for the 3730 and 3730xl instruments are 
code 128 format.
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KEYENCE 80RKE

Another option is the KEYENCE 80RKE which you connect to the instrument serial 
port. With this reader, you can scan barcode information only into specific text boxes 
within the Data Collection software. 

Note: The 80RE is not supported for either instrument.
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Running the Instrument: Manual vs Auto Mode
Accessing Modes

You may schedule a run or runs using either manual 
mode or auto mode. Both modes are described below. 
Access either mode by selecting:

Run Scheduler >Instrument > Instrument Name > 
Run mode (Auto or Manual)

Note: You must be in the Run Scheduler view to see 
the instrument run mode menu.

Manual Mode Features

The benefits and features of using manual mode are:

• Plates can be added to the stacker individually 
and in order; runs are scheduled in the order the 
plates are in the stack.

• The internal reader is not necessary to link plates 
to plate records in the local database.

• Plates do not need to have a barcode.

Scheduling Runs Using Manual Mode

To schedule runs using the manual mode (default):

1. Click the Run Scheduler icon.

2. Select Instrument > Instrument Name > 
Manual mode.
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3. Click Search in the Run Scheduler to search for 
plate record(s).

This opens the Add Plates to In Stack dialog 
box.

4. Type the name of the plate(s) or scan the plate ID 
and click Search.

Click Search Up and Down buttons

Barcode search Advanced search
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5. Select run(s) to add and then click Add to add 
the plate record(s) to the Input Stack in the order 
in which you want them to run.

6. Click Done to close the Add Plates to In Stack 
dialog box.

7. Physically stack the plates in the In Stack in 
order. The bottom plate runs first.

IMPORTANT! The order of the plate record must 
match the stack order of the plates in the In 
Stack. If the order does not match, processed 
runs will have the wrong plate record 
information.

Note: You may assign more plates in the Run 
Scheduler than are actually available in the 
stacker.

8. Click  (Run).
As the plates are retrieved by the autosampler, 
they are run in the order they were placed in the 
In Stack.
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Auto Mode Features

The features and benefits of the using Auto Mode are:

• Plates must have barcodes.
• Internal barcode reader is necessary in order to 

link plates to plate records in the local database.
• You can add plates to the In Stack in any order.
• Plates can be added or removed during 

instrument operation.

To schedule runs using the Auto mode:

1. Select Run Scheduler > Instrument Name > 
Auto mode. 
Notice that the Search, Up, and Down buttons 
are no longer visible as they are in Manual mode. 
Also, you no longer have the Add Plate (Scan or 
Type Plate ID) option as you do in Manual mode.

2. Physically place plates in the In Stack in any 
order. Remember that the bottom plate runs first, 
the top plate runs last.

3. Click  (Run).
As the plates are retrieved by the autosampler, 
plate barcodes are scanned and their plate 
records are associated with those stored in the 
local data collection database.
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Running the Instrument: Launching the Run

1. Verify the active spectral calibration matches 
your dye set and capillary array length. 

2. If you want to review the run schedule before 
beginning the run, click  

GA Instruments > ga3730 > 
instrument name > Run Scheduler

3. Click the green button in the toolbar.
The Processing Plates dialog box opens.

4. Click OK.

5. The software automatically checks:
– the capillary array length and polymer type in 

the Instrument Protocol column of the plate 
record against the capillary array length and 
polymer type

– the available space in the database and drive E

If the database 
or drive E are … Then …

full A warning displays. Do the following:

1. Make more space by deleting unneeded files. See, “Working With Drives for Database and 
Sample Data Storage” on page 174

2. Click the green button to start the run.

not full the run starts.
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Basic Run Module Steps

When the run starts, the following basic steps are 
performed automatically by the instrument

DNA Sequencing Run Times 

The following table lists the approximate run times of 
common DNA sequencing analysis runs:

 Module Steps Approximate Time

Turn Oven On N/A

Wait for oven to equilibrate
Initialize autosampler

1 min 40 sec (when 
oven is at set 
temperature)

Fill Array 3-4 min

PreRun 3 min

Inject samples 30 sec

Start separation
Ramp voltage

10 min

Collect Data Variable

Run ends: 
Leave oven on
Laser to idle

Until next run starts

Total time prior to separation:

• Cold start: ~38 minutes 

• Warm start ~10 minutes (oven is already at temperature)

Note: A PostBatch Utility, which runs automatically, 
turns off the oven and the laser at end of a batch of 
runs.

Analysis Capillary Array Length Run Module Approximate 
Run Timea (min)

Rapid read DNA sequencing 36-cm RapidSeq36_POP7 35

Standard read DNA sequencing 36-cm StdSeq36_POP7 60

Fast DNA sequencing 50-cm FastSeq50_POP7 60

Long read DNA sequencing 50-cm LongSeq50_POP7 120

Extra Long DNA sequencing 50-cm XLRSeq50_POP7 180

a. Times assume oven is at temperature
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Fragment Analysis Run Times

The following table lists the approximate run time of 
a common fragment analysis run:

Instrument Status Lights

Capillary Array Length Run Module Approximate 
Run Time (min)

36-cm GeneMapper36_POP7 32

Status Status 
Light Action

• The instrument is ready.

• An automated wizard 
operation is in progress with 
the instrument door closed.

Go to 
page 8.

• A run is in progess

• The instrument is 
downloading firmware.

• The instrument cannot 
communicate with the 
computer.

Go to 
page 7.

• The instrument is performing 
diagnostics.

• The oven door is open.

• The instrument door is open.

• The buffer reservoir is not 
installed.

• The capillary array is not 
installed.

• An automated wizard 
operation is in progress with 
the instrument door open.

Go to 
page 6.

• The instrument has detected 
a problem.

Go to 
page 7.

Flashing green

Solid green

Flashing yellow

Solid red

Flashing yellow

Solid yellow
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Controlling the Run 
You can use the toolbar at the top of the data collection software window to control 
the run.

To ... Click ... Action

Start the run Starts run(s).

Stop the current run Stops the current run.

Stop after the current run Finishes current run and then stops.

Skip to next run Stops the current run and begins next 
scheduled run.

Pause after current run Finishes current run and then waits for 
resume command to begin next 
scheduled run.

Resume after pause Begin the next scheduled run after a 
pause.
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Controlling the Run: Instrument Status 
Click  (Instrument Status) to monitor the status of the instrument or the current run.

Events Box The Events box lists the:

• Instrument’s recent actions
• Status of each capillary as passed or failed at the end of a spectral calibration 
• Calibration data at the end of a spatial calibration

Some of the events listed in the Events box provide information for service engineers.

Errors Box The Errors box lists errors that have occurred during the current run. 

Some of the error messages provide information for service engineers. A “fatal” error 
usually requires that you restart the data collection software.

System Status must be 
‘Ready’ before a run starts

System Status changes from green to 
flashing red when errors occur.

Array and polymer information
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Controlling the Run: EPT Chart
The EPT Viewer displays real-time electrophoresis (EP) data during a run.

In the tree pane of the Data Collection Software, click GA Instruments > 
ga3730 > instrument name > Instrument Status >  EPT Chart. 
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Controlling the Run: Event Log
The Event log graphically itemizes events such as errors and general information, as the 
graphic below illustrates.

In the tree pane of the Data Collection Software, click  GA Instruments > 
ga3730 > instrument name > Instrument Status > Event Log. This opens the event 

log window.

Clear error messages by clicking Clear Errors. The System Status light flashes red until 
all errors are cleared.

Note: This view can also be used to monitor a spectral calibration run in real time to 
verify the capillary-by-capillary processing status.

Note: If an error is generated while using manual control,  re-boot the instrument and 
Data Collection software to recover from the error stage.
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Controlling the Run: Capillary Viewer

Viewing Data in
the Capillary

Viewer

Use the Capillary Viewer to examine the quality of electropherogram data during a run 
for several capillaries at once.

In the tree pane of the Data Collection Software, click  GA Instruments > 
ga3730 > instrument name > Instrument Status >  Capillary Viewer.

Electrophero-
gram Displays

An electropherogram is a graph of relative dye concentration against time, plotted for 
each dye. The data displayed has been corrected for spectral overlap 
(multicomponented). 

How to Zoom To zoom:

1. Hold and drag the mouse over the area of interest. 

2. Release the mouse, then click  to expand the view.

3. Click  to return to full view.

Click individual colors to view or hide them. 
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Viewing Data in
the Array Viewer

Use this during or after a run to examine the quality of your data, which is displayed as 
color data for the entire capillary array. You can view all the capillaries (vertical axis) as 
a function of time/data point (horizontal axis).

In the tree pane of the Data Collection Software, click  GA Instruments > 
ga3730 > instrument name >  Array Viewer. This opens the Array Viewer 

window.

How to Zoom 1. To expand the view, hold and drag the mouse over the area of interest. 

2. Click  to return to full view.

Color Bar

Click individual colors to view or hide them (same in Capillary Viewer).

Capillary 1

Capillary 96

or

Capillary 48



Working with Data in The Run History View
Color Bar

Applied Biosystems 3730/3730xl DNA Analyzer User Guide 143

Notes

6

Working with Data in The Run History View

Run History
Components

The Run History utility can be used only with completed runs stored in the local 3730 
Data Collection database. It does not provide real-time viewing of collecting runs.

In the left tree pane, click the icon next to the function to launch it.

Viewing Data from
a Completed Run

in the
Data Collection

Software

There are two formats for viewing data within the 3730 Data Collection Software under 
the Run History icon:

• In the Array Viewer window
• In the Capillary Viewer window, capillary-by-capillary

Elements Within the Run History Utility Icon

EPT Viewer

Note: If Cleanup Database has been used, you cannot view 
processed data in Run History. 

Spatial Calibration Viewer 

Capillary Viewer

Note: If Cleanup Database has been used, you cannot view 
processed data in Run History. 

Array Viewer

Note: If Cleanup Database has been used, you cannot view 
processed data in Run History. 

Spectral Calibration Viewer

Reextraction 

Note: If Cleanup Database has been used, you cannot view 
processed data in Run History. 
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Viewing Data from
a Completed Run

1. On the left tree pane in the 3730/3730xl Data Collection software, click 
(Run History) to select the run you want to view.

2. Search for your run by either Barcode or Advanced search. 

3. After choosing the run, click the Array Viewer or the Capillary Viewer from the left 
tree pane. 
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Viewing the Results of Autoextraction
After a run is completed, extraction and analysis is performed automatically, according 
to the settings in the Plate Editor and the Results Group. The results of extraction and 
analysis can be viewed in the Reextraction Panel. Samples can be extracted again with 
the same settings, or with different Analysis Protocols or different Results Groups. This 
can be useful for several reasons:

• The destination location may not have been available during extraction.
• Some samples may have failed analysis and a different Analysis Protocol might be 

more successful.
• Samples might be saved in different locations, or with no analysis at all to 

save space.
• Sample files are created based on the your destination and folder naming selections.

Runs Stopped
Before Complete

Autoextraction

Runs that are stopped before completion display the status “Completed” in the Run 
Scheduler and the plate is moved to the Out Stack. In the Instrument View the status is 
changed to “Ready.” Successfully extracted and analyzed runs display the status 
“Processed” in the Run Scheduler. 

The auto extractor component of the 3730/3730xl Data Collection automatically extracts 
data from stopped runs. If autoextraction fails, click the Reextraction icon  to 
extract data.

Effects of
Changes Made in
the Reextraction

Panel

Changes made in the Reextraction Panel to a Sample name, Analysis protocol, etc., also 
change in the original plate record. The original plate information is overwritten.
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Selecting and Queuing Samples for Reextraction

You can queue individual samples for reextraction. This is especially useful for 
experimenting with different Analysis Protocols for samples that have failed 
initial extraction.

1. Click   (Run History).

2. Enter the plate ID for a plate that has been completed, or click Search. Plates that 
have runs still pending cannot be reextracted. All the runs from that plate appear in 
the window. 

3. Select a run from the list. 

4. Click  (Reextraction) in the left tree pane.
The Reextraction window displays

5. Click the checkboxes in the Extract column to select the samples to be reextracted.

6. Click Extract to start the reextraction. 

Note: Reextracted sample files are saved in the original folder that data was extracted 
to, unless you modify the results group settings.
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Elements of the Reextraction Window

All the samples are displayed with the results of 
extraction and analysis. 

Reextraction Window for Sequencing 
Analysis

Note:  Sort the columns of the re-extraction panel by 
holding the shift key and then clicking on a column 
header.

Use check boxes to 
select samples to 
be reextracted Results of extraction and analysis

Click here to start extraction These are used if several 
samples are highlighted

Select a run
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Reextraction Window for Fragment 
Analysis

Use check boxes to 
select samples to 
be reextracted Select a run Results of extraction 

Click here to start extraction These are used if several samples are highlighted
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Results Column The results of extraction and analysis are color coded in the Results column. The 
following table lists the colors and their values.

The Results column, by default, shows only the beginning of any processing message. 
The entire message returned from extraction and autoanalysis is inside the cell and can 
be viewed by expanding the cell. The location of the stored sample is also found there. In 
addition, there is a tooltip view for each sample results message.

Color Value Notes

Red Extraction or analysis failed Descriptive messages can be viewed by 
resizing the Results column to view all text 
(click on the arrow)Yellow * Warnings for extraction or analysis

Green Successful extraction (with no analysis intended), or 
successful extraction and analysis.

* Note: The text message for samples that produce yellow is: “FAILURE: Analysis Failed

                                                                                                  Bad Data; Error Number=nnnnn

                                                                                                  WARNING...

Tooltip view. Access by placing the cursor over the sample of interest

Expanded column
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Quality Column The Quality column represents the quality values for an entire sequence. Quality Values 
are only assigned to analyzed samples when using the KB Basecaller. The following 
table lists the displayed colors and their associated value range.

The column is empty (white) if:

• Analysis was not performed
• Analysis failed
• ABI Basecaller was used for analysis. This basecaller does not assign 

Quality Values.

Results Group and Analysis Protocol Columns

The Results Group and the Analysis Protocol (Analysis Method in the GeneMapper™ 

software) can be edited and the changes used for reextraction.

Note: Select an entire column in the Reextraction window by clicking on the column 
header. For example, clicking on the Extract column header selects all samples. Clicking 
the Uncheck or Check buttons at the bottom of the window, enables or disables the 
checkboxes for each sample. Additionally, the fill-down command (Ctrl+D) works the 
same here as in the Plate Editor for easier information input.

Sorting The Samples 

The samples can be sorted according to any of the column properties by holding down 
the shift key while clicking on the column header. Shift-clicking again sorts them in the 
reverse order. This is most useful for sorting by capillary number, by well position, by 
results, by quality, and by the Extract column. For example, it is often useful to bring all 
of the samples that failed analysis or extraction to the top of the column where they can 
be examined without having to scroll down to each sample individually.

Color Quality Value Range

Red < 15

Orange ≥ 15 and < 20

Yellow ≥ 20 and < 30

Green > 30

Note: For more information on KB Basecaller and Quality Values, see the Applied 
Biosystems DNA Sequencing Analysis Software v5.1 User Guide, PN 4346366.
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Reextracting Selected Samples

1. Expand the Results column cells for any yellow 
or red results, to see a description of the warning 
or failure.

2. If desired, select a new Results Group, or edit the 
current one. This allows you to turn off 
autoanalysis, change the samples and folder 
naming options, the location where they are 
placed, the owner of the Results Group, etc. 

3. If desired, change the Analysis Protocol to 
experiment with different ways of analyzing the 
sample, using a different basecaller for example.

4. Check the check box in the Extract column for 
the samples you wish to extract again.

5. Click Extract.

IMPORTANT! Reextraction creates an entirely 
new sample file and does not replace the 
previously saved sample file. The presence of a 
previous sample file has no effect on the creation 
of a new sample file. If the same naming options 
that are used for reextraction are identical to 
those used previously, a number is appended to 
the filename. For example, if the first sample is, 
“sample 01.ab1” then the second sample would 
be, “sample 01 (1).ab1.”
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Performing Maintenance

Workflow

Clean the pump block and
lower polymer block

Flush and fill 
the water trap

Perform a 
short-term shutdown

Store a capillary array

Delete records
from the databse

Defragment the
computer hard drives

Archive data

Performing
Maintenance

Performing
Spatial Calibration

Performing
Spectral Calibration
for Sequencing and
Fragment Analysis

Setting Up
the Software for
DNA Sequencing

Setting Up
the Software for
Fragment Analysis

Running
the Instrument

Preparing the
Instrument

Audit Trails
and Access Control

See page 157

See page 167

See page 170

See page 168

See page 176

See page 178

See page 179
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Performing Maintenance Tasks

Overview This section lists common tasks required to maintain your Applied Biosystems 
3730/3730xl DNA Analyzer in good working condition. The tasks are divided into tables 
based on how often you should perform each task.

 Wear appropriate protection, including gloves, laboratory goggles, 
and coat whenever you work with the fluids used on this instrument, or parts that may 
come into contact with these fluids.

Daily Tasks Perform these tasks at least once per day.

Maintenance Task Frequency

Ensure adequate levels of buffer and water in reservoirs. Before each run

Ensure the plate assemblies are properly assembled. 

IMPORTANT! The holes in the plate retainer must align with the 
holes in the septa, or the capillary tips will be damaged.

Before each run

Ensure the plate assemblies are positioned on the plate deck properly. 
Plates should sit snugly on the deck. 

IMPORTANT! Never use warped plates.

Before each run

Check the level of buffer in the buffer jar and ensure that the overflow 
hole is not occluded and, that the overflow hole is facing toward the 
front of the instrument.

Before each run

Replace the water and 1X run buffer in the reservoirs on the instrument 
and, make sure that the outside of the assemblies are dry.

Every 48 hours

Check for bubbles in the pump block, lower polymer block, 
interconnect tube, polymer supply tube, and channels.

Remove all bubbles with the Bubble Remove wizard.

Daily or before each 
run

Check the loading-end header to ensure the capillary tips are not 
crushed or damaged.

Daily or before each 
run

Check the level of polymer in the bottle to ensure sufficient volume for 
runs.

Daily or before each 
run

Check the pump block and the lower polymer block to ensure they fit 
securely on the instrument.

Daily

Clean the instrument surfaces. Daily

Check for leaks around the array knob, interconnecting tube nuts, and 
check valve.

Daily
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Weekly Tasks Perform these tasks at least once per week.

Monthly Tasks Perform these tasks at least once per month.

As-Needed Tasks Perform these tasks as needed.

Maintenance Task Frequency

Replace the polymer using the Change Polymer Wizard. Weekly or as 
needed

Check the storage conditions of the used arrays. Weekly

Maintenance Task Frequency

Run the Water Wash Wizard.

Flush the array port during this wizard, whether or not bubbles are 
present in the array port.

Monthly or as 
needed

Flush the water trap (see page 167). Monthly or as 
needed

Maintenance Task Frequency

Clean the drip tray. As needed

Change the array. As needed

Remove any dried polymer from the capillary tips. Use a lint-free wipe 
moistened with deionized water.

As needed
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General
Instrument

Cleaning

To clean the instrument:

1. Ensure the oven door, the instrument door, and the stacker are closed.

2. Press the Tray button on the front of the instrument to move the autosampler to the 
forward position.

3. Wipe off any liquid on or around the autosampler using a lint-free tissue.

4. Clean out the drip tray with deionized water and lint-free tissue.

5. Clean off any polymer build-up (crystals) on the instrument including the capillary 
tips with deionized water and lint-free tissue. 

IMPORTANT! Never use organic solvents to clean the instrument or any of 
its components.
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Guidelines for Pump Block and Lower Polymer Block 
Cleaning

Cleaning Exterior Surfaces

• Do not expose the polymer blocks to organic 
solvents.

• Do not use sharp or pointed instruments to 
remove dried polymer from the polymer blocks. 

• Do not use water > 50 °C to clean the polymer 
blocks.

When to Clean the Pump Block and the 
Lower Polymer Block

• Clean the exterior every 7 days, when polymer is 
replenished.

• Clean the Polymer Delivery Pump (PDP) 
chamber, channels, and tubing once per month.

Cleaning the PDP Chamber, Channels and 
Tubing

1. Run Water Wash Wizard. 

2. Inspect the channels of the Pump and Lower 
blocks for any possible contaminants. Repeat 
Water Wash Wizard until contaminants are 
removed.

CHEMICAL HAZARD. POP-7 
polymer may cause eye, skin, and respiratory tract 
irritation. Please read the MSDS, and follow the handling 
instructions. Wear appropriate protective eyewear, 
clothing, and gloves. Use for research and development 
purposes only.

Polymer Block Cleaning

Su M T W Th F S

7 days
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Overview

The five wizards in the Data Collection Software v2.0 
guide you through several maintenance procedures.

General Use Guidelines

The following table lists the wizards and when to use 
them.

Wizard When to Use

Install Array • To install a capillary array:

– On a new instrument

– To reactivate an instrument that has been shut down

• To replace an installed capillary array with another capillary array

• To install an array without the wizard when the Data Collection software is reinstalled or upgraded

Change Polymer • To replenish the polymer supply 

• To replace the polymer in the PDP with polymer of the same or different lot

• To enter polymer information when Data Collection software is installed or upgraded

Bubble Remove • To remove bubbles in the PDP chamber, channels, and tubing

Water Wash • To wash the PDP chamber, lower polymer block*, channels, and tubing with water:

– As part of a monthly maintenance protocol

– To remove any suspected contaminants in the PDP

– To remove persistent bubbles (followed by the Bubble Remove Wizard, if needed)

– To replace old polymer in the PDP

* The lower polymer block should not be removed; clean on the instrument using this wizard.

Instrument 
Shutdown

• To prepare the instrument for a period of disuse of greater than one week

• To remove the array without the wizard
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Using Wizards
with the

Instrument Door
Open

IMPORTANT! Polymer Delivery Pump (PDP) operations with the door open are 
permitted only in wizards. If the door is opened at any other time during instrument 
operation, most functions, including PDP operations, are paused.

All wizards include instructions for manual operations and buttons that launch specific, 
automated operations of the Polymer Delivery Pump (PDP). You can use the 
3730/3730xl version 2.0 to perform most automated operations of the wizards with the 
main instrument door open. With the door open, you can easily view the operations of 
the PDP, making possible close monitoring of bubble clearing and fluid changing. The 
wizards may also be performed more quickly, since the instrument door need not be 
closed (triggering a wait period for the green status light to illuminate) and opened 
repeatedly when the automated procedures are performed. Guidelines for using the 
capability to run automated wizard procedures with the door open are given in the 
guidelines table in the next section.

Guidelines for
Wizard Use

Depending on
Instrument Door

State

Follow the suggestions below to use the wizards effectively when the door is open or 
closed.

IMPORTANT! Whenever the door is closed (whether or not a wizard is open, or an 
automated procedure is in progress), the autosampler moves while determining 
position (initialization). Always wait for the autosampler to stop moving (finish 
initialization), and the green status light to illuminate before initiating any 
automated procedures. If you accidentally start an automated procedure while the 
autosampler is in motion, you may encounter irregularities in the instrument 
behavior. An error may be displayed in the Data Collection event window. 
However, you should be able to complete the Wizard. Restart the instrument and 
the Data Collection software. 

If You... With the 
Instrument Door ... Then ...

IMPORTANT! Do not open or close the instrument door while an automated procedure is in progress. Leave the door in 
the starting state (whether open or closed) until the automated procedure is complete.

Begin an automated 
procedure 

Open The procedure continues when the door is closed, and after the 
autosampler moves to initialize. If you open the door again, the 
procedure pauses until the door is closed.

Begin an automated 
procedure 

Closed The procedure pauses if the door is opened. Close the door again to 
resume the procedure.

Click Fill Array Open The procedure does not start; the door must be closed.

Perform an automated 
procedure 

Closed The green status light remains on (not flashing)

Perform an automated 
operation

Open
The yellow status light flashes.

Note: Regardless of whether or not automated procedures are in progress during wizard use:

• If the instrument door is closed, then the green status light remains on (not flashing)

• If the instrument door is open, then the yellow status light flashes
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Specific Use Guidelines

If ... Then ... Explanation

The polymer has 
been in the pump 
longer than 1 week 

Use the Water Wash Wizard (instead 
of Change Polymer Wizard) to 
replace the polymer.

Using the Water Wash Wizard ensures that the system is 
well cleaned before fresh polymer is introduced. 

Urea decomposition can cause an increase in 
electrophoresis current in polymer that has been at room 
temperature for more than 1 week.

Bubbles move but 
are not completely 
cleared by the 
Bubble Remove 
Wizard

Use the Bubble Remove Wizard 
repeatedly until the bubbles are 
gone.

When clearing bubbles with repeated use of the wizard, 
note whether or not the target bubbles have moved during 
performance of the Wizard. Any bubbles that move but are 
not entirely cleared by running the wizard are likely to be 
cleared with a repeat of the Bubble Remove Wizard.

You want to clear 
persistent bubbles

Try one or both of the following:

• Run the Water Wash Wizard followed, if necessary, by the Bubble Remove Wizard. (The Water 
Wash Wizard includes refilling the pump with polymer.)

• Remove the polymer bottle and run the Bubble Remove Wizard (a large amount of air will be 
drawn into the pump chamber and other parts of the system). Reinstall the polymer bottle and 
repeat the Bubble Remove Wizard to remove all bubbles.

Note: If the pump sits idle for a time, bubbles that previously did not move are often cleared by running the 
Bubble Remove Wizard.

Many, or large 
bubbles are present 
in the pump 
chamber

The Water Wash Wizard may help to 
remove bubbles.

No bubbles are 
present in the array 
port during the 
monthly water wash 
procedure

You should still perform the Flush 
Array Port procedure using the Water 
Wash Wizard as part of monthly 
maintenance, even if no bubbles are 
present. 

Occasional flushing of the array port keeps this space filled 
with fresh solution.

You want to install a 
capillary array on an 
instrument without 
an array

Perform the Fill Array procedure at 
the end of the Install Array Wizard.

Filling the array helps to ensure complete changeover to 
polymer in this situation where the PDP has been 
extensively washed with water.

You remove or 
install a capillary 
array

Carefully follow the instructions in the 
appropriate wizard (Install Array or 
Instrument Shutdown wizards). 

Ensure that the instrument 
configuration and the database 
information agree.

A mismatch between the array configuration/identification 
and the database information may cause incorrect analysis 
parameters and result in reduced basecalling accuracy.

You select Discard 
during installation of 
an array using the 
Install Array Wizard

The information for that array cannot 
be entered again on the instrument.

You plan to leave 
the instrument 
unused for more 
than 1 week

Use the Instrument Shutdown 
Wizard.
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You are using the 
Install Array Wizard 
to reactivate the 
instrument

First turn on the instrument power to 
activate the wizard menu in Data 
Collection.

The instrument must be powered for the wizards to be 
available through Data Collection. If the instrument is 
turned off, the wizard names in the pull-down menu are 
grayed out.

You cancel a wizard 
during an 
automated 
procedure

The piston motion in progress will 
finish before the wizard is terminated.

The piston cannot stop immediately. During the period 
between cancellation and termination while the piston is in 
motion, a “Please wait...” dialog box displays.

You want to move 
the pump block on 
the mounting pins

Grasp the body of the pump, not the 
water seal fixtures.

Excessive force can damage the water seal fixtures.

You want to clean 
the array port knob, 
plug, or opening

Carefully clean the threads of these 
parts with moistened lab wipes.

Dried polymer deposits on the threads may cause poor 
sealing when the parts are rejoined.

You want to clean 
the PDP with the 
Water Wash wizard

Use only deionized water at ≤ 40 °C Hot water may damage the PDP seals and joints. Do not 
use any solutions or fluids in the instrument other than 
water and polymer.

If ... Then ... Explanation
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Wizard Flowcharts
The five wizards are depicted below as flowcharts. 
Each flowchart shows decision branches and 
alternative pathways. 

Install Array Wizard

Finish

Start the Install Array Wizard

If an array is installed

Start the Install Array Wizard

Enter polymer
information

Install the array

Install polymer

Flush

Finish

Verify the
instrument

configuration

Wash the pump,
channels, and

tubing with water

Install an array
for instrument
reactivation

Install an array
for new PDP

Install
water bottle

Are
bubbles present

in the array 
port?

Does
the array need 
to be filled with 

polymer?

Are
bubbles
present?

If an array is not installed

Remove bubbles

Fill array

Loosen array knob

Flush array port

Tighten array knob

Install the array

Prime the pump with 
fresh polymer

Finish

Store an array Discard an array

Fill the array
with polymer

Are
bubbles present

in the array 
port?

Does
the array need 
to be filled with 

polymer?

Are
bubbles
present?

Remove bubbles

Fill array

Loosen array knob

Flush array port

Tighten array knob

NO

YES

YES

YES

NO

NO

NO

YES

YES

YES

NO

NO

Enter array information

Finish

Enter array information

Remove and store
the array

Remove and
discard the array
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Change Polymer Wizard

Enter polymer
information

Prime the pump with
fresh polymer

Replace polymer

Finish

Start the Change Polymer Wizard

Install polymer
from the same lot

Are
bubbles present

in the array 
port?

Does
the array need 
to be filled with 

polymer?

Are
bubbles
present?

Remove bubbles

Fill array

Loosen array knob

Flush array port

Tighten array knob

NO

YES

YES

YES

NO

NO

Install polymer
from a different lot
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Bubble Remove Wizard

Finish

Remove bubbles

Are
bubbles present

in the array 
port?

Does
the array need 
to be filled with 

polymer?

Are
bubbles
present?

Remove bubbles

Fill array

Loosen array knob

Flush array port

Tighten array knob

NO

YES

YES

YES

NO

NO

Start the Bubble
Remove Wizard
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Water Wash Wizard

Enter polymer
information

Replace polymer

Flush with 
fresh polymer

Finish

Are
bubbles present

in the array 
port?

Does
the array need 
to be filled with 

polymer?

Are you
installing polymer

from the same
lot?

Are
bubbles
present?

Start the 
Water Wash Wizard

Install the 
water bottle

Remove bubbles

Fill array

Loosen array knob

Flush array port

Tighten array knob

Wash the pump,
channels, and

tubing with water

NO

YES

NO

YES

YES

YES

NO

NO
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Instrument Shutdown Wizard

Finish

Remove and discard
the array

Clean the buffer jar

Clean the reservoirs

Finish

Flush the pump,
channels, and

tubing with water

Start the Instrument Shutdown Wizard

Store the array Discard the array Shut down
without the wizard

Remove and store
the array

Clean the buffer jar

Clean the reservoirs

Finish

Flush the pump,
channels, and

tubing with water

Fill the array
with polymer
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Flushing and Filling the Water Trap

Overview

The PDP water trap should be flushed with either 
distilled or deionized water at least once per month to 
wash out any diluted polymer, and to clear bubbles. 
Leave the trap filled with either distilled or deionized 
water.

To flush the water seal trap:

1. Fill the supplied 20 mL, all-plastic Luer lock 
syringe (PN 4324463) with distilled or deionized 
water. Expel any bubbles from the syringe. 

Note: Do not use a syringe smaller than 20 mL. 
Doing so may generate excessive pressure within 
the trap.

2. Attach the syringe to the forward-facing Luer 
fitting at the top of the pump block. Hold the 
fitting with one hand while threading the syringe 
onto the fitting with the other hand.

3. Open the Luer fitting by grasping the body of the 
fitting and turning it and the attached syringe 
approximately one-half turn counterclockwise.

4. Open the exit fitting at the top left side of the 
pump block by turning it approximately one-half 
turn counterclockwise.

5. Hold an empty tube or beaker under the exit 
fitting to receive approximately 5 mL of waste. 
Flush the trap by pushing steadily on the syringe 
plunger.

IMPORTANT! DO NOT USE EXCESSIVE 
FORCE when you push the syringe plunger as 
this may damage the trap seals. Take 
approximately 30 seconds to flush 5 mL of either 
distilled or deionized water through the trap.
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6. Close the fittings in this order by turning each 
clockwise until the fittings seal against the block:

a. Luer fitting, first
b. Exit fitting, second

7. Remove the syringe from the Luer fitting. Hold 
the fitting with one hand while turning the 
syringe counterclockwise with the other hand.

Storing a Capillary Array

1. Remove the capillary array from the instrument 
using the Install Array wizard.

Note: Because the water trap volume is 
approximately 325 µL, a relatively small volume 
of water is adequate for complete flushing. 
However, a larger volume only improves 
flushing, as long as force and flow rate are kept 
within the limits given above

IMPORTANT! Do not over-tighten the fittings. 
Very little pressure develops within the trap 
during pump operation, so the fittings require 
only enough tightening to prevent water leaks. 
Excessive tightening can damage the fittings.

To maintain serviceability during 
storage, keep both ends of the capillary array 
immersed in 1X run buffer. Failure to do so may result 
in array damage.

IMPORTANT! Wear appropriate protection including 
gloves, laboratory goggles and coat whenever you 
work with the fluids used on this instrument or parts 
that may have come in contact with these fluids.

If You ... Then ...

Follow the Install Array 
Wizard instructions

The capillaries are filled 
with fresh polymer and 
some of the steps 
described below will be 
complete when the array 
is removed.

Remove the array without 
using the Array Wizard 
instructions

The capillaries should first 
be filled with fresh 
polymer.
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2. Put 80 mL of 1X run buffer in the capillary array header shipping cover.

3. Lower the capillary tips of the array header into the shipping cover and lock the 
header onto the cover. The tips of the capillaries should be immersed in buffer.

4. Clip the detection cell window cover onto the detection cell.

5. Attach the detection cell with its cover to the storage post on the array frame.

6. If the array knob and double-tapered ferrule are on the array tip:
a. Remove them and rinse them with deionized water.
b. Dry the parts with a lab wipe.
c. If they are not to be used immediately, store them in a safe place.

7. Clean the array tip carefully with a lab wipe moistened with deionized water.

8. Attach the array tip shipping vial filled with 1X run buffer to the array tip. Loosen 
the vial cap slightly, insert the tip and then tighten the cap.

9. Clip the vial with the array tip onto the array frame.

10. Store the capillary array upright in a safe area.

IMPORTANT! Check the 1X run buffer levels in the shipping cover and vial at least once 
a week; replenish the buffer as necessary to keep the both ends of the capillaries 
immersed in buffer.
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Performing a Short-Term Shutdown
Perform the short-term shutdown procedure if you 
will use the instrument again in 7 days or less.

Materials Required

• 1X Run Buffer 
• POP-7 polymer
• Deionized water
• Lab wipes
• Gloves

Performing a Short-Term Shutdown

1. Close the instrument door.

2. Press the tray button to bring the autosampler to 
the forward position.

3. Wait for the:
• Autosampler to stop moving
• Green status light to illuminate 

then open the instrument door.

4. Remove the buffer, water, and waste reservoir 
assemblies from the instrument.

5. Disassemble each reservoir assembly and empty 
the contents of the reservoirs into an aqueous 
waste container.

Su M T W Th F S

≤ 1 week

Instrument door

Tray
button

Status 
lights

Aqueous 
Waste
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6. Rinse each reservoir using deionized water.

7. Dry the reservoirs using lint-free wipes.

8. Fill and assemble the reservoirs.

9. To prevent damage to the capillary array, inspect 
each reservoir assembly and verify that the:

• Septa fit snugly and flush on the reservoir

• Rubber gasket around the edge of the 
reservoir cap is seated

• Plate retainer holes and the septa strip are 
aligned

DI H2O ≤ 50 °C

Buffer Reservoir Assembly Water and Waste Reservoir Assemblies

1. Add 80 mL 1✕ running buffer to the Buffer reservoir.

2. Assemble the reservoir assembly as shown below: 

1. Add 80 mL high-quality deionized water to each
reservoir (Water and Waste).

2. Assemble each reservoir assembly as shown below: 

GR2210

Retainer

Septa

Reservoir cap

Reservoir

Heated plate base

Power cable

Retainer

Septa

Reservoir cap

Reservoir

Plate base

Rubber gasket 
not seated 
correctly

Plate retainer holes 
and septa holes are 
not aligned



Chapter 7 Performing Maintenance
Performing a Short-Term Shutdown

172 Applied Biosystems 3730/3730xl DNA Anaylzer User Guide

10. Dry the reservoirs using lint-free wipes.

11. Connect the Buffer reservoir plate base cable 
into the heater outlet within the instrument.

12. Place the Water and Waste reservoirs into the 
instrument. All three reservoirs will be in the 
following order:

a. Buffer reservoir 
b. Water reservoir 
c. Waste reservoir 

13. Close the instrument door.

14. Press the tray button.

15. Press the instrument power button.

Lint-free wipe

Buffer position

Buffer reservoirIMPORTANT! After placing the buffer reservoir, 
make sure the cable is out of the way of the 
autosampler.

12a 12b 12c

Instrument door

Power
button
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16. Shut down the computer:
a. Select > Shutdown.
b. In the Shut Down Windows dialog box, 

select Shut down from the drop-list.
c. Click .

17. Press the power button on the monitor.

19b

19c
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Working With Drives for Database and Sample Data Storage

Checking
Available Space
on Drives D, E,

and F

Before a run or batch of runs, the Data Collection software automatically checks the 
available space to ensure sufficient space to store the database and sample file data you 
create. 

The Data Collection software sends a warning message to remove data when the drive is 
getting full and/or clean up the database when the database is getting full (~80% of 
capacity). An error is generated and displayed in the Instrument Status window in the 
Errors pane and in the Event Log window in the Errors pane. Also, the status light in the 
bottom left-hand corner of the data collection window flashes red.

Full Database
Error

To view the error messages, click GA Instruments > ga3730 > 
instrument name > Instrument Status> Event Log.

Cleaning Drives Ensure that you have sufficient drive space by regularly:

IMPORTANT! Runs can not be started until the data is removed from the drive and/or database is cleaned up.

Status light

• Archiving data • Deleting unneeded files

• Emptying the recyle bin • Defragmenting the drives
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Hard Disk Status

Checking Available Disk Space on Drive E

1. In the Tree pane of the Data Collection Software, click 
GA Instruments > Database Manager.

The Database Manager view opens.

Checking available drive E space

2. If there is insufficient space:
a. Archive the sample files to a CD-RW (see page 176) or another volume.
b. Delete the sample file data from the drive E and empty the contents of the 

Recycle Bin.

Check disk space status here



Chapter 7 Performing Maintenance
Archiving Data

176 Applied Biosystems 3730/3730xl DNA Anaylzer User Guide

Archiving Data

Creating a Data CD

A basic version of Roxio Easy CD Creator™ 5 
software was loaded on your Dell™ computer. Use 
this software to archive data to a CD. The software is 
also part of the CD set you received with your Dell 
computer.

To archive data:

1. Select Start > Programs > Roxio Easy CD 
Creator 5 > Applications > Easy CD Creator.

The Untitled - Easy CD Creator dialog box 
opens.

2. For help creating a data CD, select Help > 
Contents and Index.

3. In the left tree pane, select Making Data CDs 
for Archiving and Sharing > Making a Data 
CD.
Use the instructions to create the CD.
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Instructions for creating a data CD
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Defragmenting the Computer Hard Drives
The fragmentation of files decreases the performance 
of both the data collection software and the computer 
operating system. As the hard drive becomes 
fragmented, programs take greater time to access files 
because they must perform multiple seek operations 
to access the fragments. 

When to Defragment the Computer Hard Drive

Defragment the computer hard drive:

• at least once every month.
• before fragmentation reaches 10%.

Defragmenting the Hard Drive

1. In the Windows desktop, right-click 
My Computer ( ), then select Manage.

2. In the Tree tab of the Computer Management 
dialog box, click Computer Management 
(Local) > Disk Fragmenter.

3. Select the E drive.

4. Click .
The computer displays the Defragmentation 
Complete dialog box upon completion of the 
defragmentation of the drive.

5. In the Defragmentation Complete dialog box, 
click .

6. In the Computer Management dialog box, 
click .
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Deleting Records from the Database 

Deleting Processed Frame Data

1. In the Tree pane of the Data Collection Software, 
click GA Instruments > Database 
Manager.
The Database Manager view opens.

2. Click Cleanup Processed Plates.

The following dialog box opens.

3. Click .

IMPORTANT! The Cleanup Database utility deletes all 
run data and plate records in the database. Before running 
the utility, be sure that all runs have been extracted from 
the database.

Note: There is no need to re-import the spatial 
and spectral calibrations or the custom run 
modules.

Note: It may take several minutes to clean up the 
database if it is full or contains a lot of data.



Chapter 7 Performing Maintenance
Deleting Records from the Database

180 Applied Biosystems 3730/3730xl DNA Anaylzer User Guide



Applied Biosystems 3730/3730xl DNA Anaylzer User 181

Notes

8

Audit Trails and Access Control

Workflow

Enable the access control
and audit features

Export/import user settings,
applications, group profiles

Start the AB Navigator

Configure the audit map

View the audit history

Set up password policies

Create a new user

Create a new profile
Audit Trails
and Access Control

Audit

Access Control

Performing
Spatial Calibration

Performing
Spectral Calibration
for Sequencing and
Fragment Analysis

Setting Up
the Software for
DNA Sequencing

Setting Up
the Software for
Fragment Analysis

Running
the Instrument

Performing
Maintenance

Preparing the
Instrument

See page 195 

See page 190

See page 186

See page 183

See page 185

See page 197

See page 202

See page 207
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Audit 
Audit trails maintain a history of data changes made by the user. 

Data Changes
that Generate

Audit Records in
Data Collection

Software

An audit record is generated when data are changed. The following table lists the three 
general categories and the events within them that generate an audit record in Data 
Collection software.

Reason For
Change

When a change occurs and auditing is required, the Reasons For Change dialog displays 
and contains:

• The attribute that was created or changed.
• The old and new values, if applicable, in the top half of the dialog box.
• A Text box to enter the reason for the change.

– When you click OK, changes to the attribute and the audit data are saved.
– When you click Cancel, no changes are saved and you return to the previous 

window.

Plate Record Run Module Results Group

An audit record is 
generated in Data 
Collection software 
when you ...

• Create, edit, or 
import a plate 
record

• Create, edit, or 
import a run 
module

• Create, edit, or 
import a results 
group

Parameter changes

Reason for changes
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Enabling The Access Control and Audit Features

Enabling Access Control (Security)

1. Start the following:
– Data Collection services: Start > Programs > 

Applied Biosystems > Data Collection > 
Run Data Collection 3730 v2.0.

– Administrator application: Start > Programs 
> Applied Biosystems > Administrator.

2. In the System Authentication dialog box, type 
Administrator for the login name and type your 
password if you have changed it; if not, type 
Administrator.

3. In the left pane tree double-click Access Control 
Administration.

4. Select Applications > FoundationViewerApp.

5. Select the Challenge checkbox to activate it.
The Login and Password dialog box is now 
enabled.

6. Select File > Save.

7. Exit Access Control Administration
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Enabling Audit

1. In the Navigator left pane tree, double-click 
Audit Map Configuration.

2. Select the Enabled checkbox for each audit map 
to activate it:

• DC Plate Record
• DC Run Module
• DC Results Group

3. Exit Audit Map Configuration.
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Starting AB Navigator
AB Navigator is the access point for these 
applications:

• Audit Map Configuration
• Audit Map History Viewer
• Access Control Administration 

1. Start the Data Collection Services, then start the 
Administrator application:

a. Data Collection services: Start > Programs 
> Applied Biosystems > Data Collection > 
Run Data Collection 3730 v2.0.

b. Administrator application: Start > 
Programs > Applied Biosystems > 
Administrator.

The System Authentication dialog box displays.

2. Enter login name and password and click OK.
Default login name: “Administrator” 
Default password: “Administrator”

IMPORTANT! You must start Data Collection 
services in order for AB Navigator to function 
properly. 

Note: To change your password, see step 4 
on page 203
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3. In the left pane tree, click Administration to 
expand the options.

Audit Map Configuration
The Audit Map Configuration Tool is used to manage 
Audit Maps. Audit Maps are used to control how 
auditing is done for a given functional area. 

Some features of the Audit Map Configuration Tool:

• You can set the audit states of an audit map to 
On, Off, or Silent.

• There is no SAVE command. All changes to 
audit maps are saved automatically. 

Starting the Audit Map Configuration Tool

1. Double-click the Audit Map Configuration icon 
in the left pane tree.

The System Authentication dialog box displays.
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2. In the System Authentication dialog box, type 
Administrator for the login name and type your 
password if you have changed it; if not, type 
Administrator.

3. Click OK.
The Audit Map Configuration window displays.

Audit Map Configuration Functions

Audit Map Configuration Functions:

If you want to ... Then ...

Enable or disable all the attributes in an 
audit map

Select or deselect a cell in the Enabled column in the Audit Map Objects 
pane.

Sort a row  Click on a column header.

Note: Disabled Audit Maps (Enabled column) display their attribute list in italics.

Audit Map 
Objects
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Commands The following table lists the commands you can perform in the Audit Map Configuration 
Tool.

Toolbar 
Menu Command Function

File Go To Displays a list of applications that are currently running; 
select an application to go to that application

Visual Print Displays Print Dialog

Visual Print 
Preview

Displays Print Preview

Exit Application Exits the Audit Map Configuration application

Exit AB 
Navigator

Exits the AB Navigator application

Auditing On Select auditing to be turned on for the Audit Map 
Configuration. 

When a change is made to an Audit Map’s enabled state 
or when a change is made to the state of an attribute, 
auditing occurs, and A Reason For Change (RFC) dialog 
displays.

Silent When a change is made to an Audit Map’s enabled state 
or when a change is made to the state of an attribute, 
auditing occurs. Although the RFC Dialog does not 
display, a ‘silent’ Audit Record is created.

Note: Changes to the auditing state from this toolbar menu item (Auditing) 
applies only to the Audit Map Configuration tool. To change the auditing 
states of Data Collection software functional areas, see the section below.

When RFC Dialog 
Displays and You... Then ...

Click OK The map or attribute state 
changes and an Audit 
Record is created.

Click Cancel The map or attribute state 
does not change.
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Attribute States When you click an Audit Map Object, the Attributes Pane displays.

Change
Description

This function controls the Reason for Change dialog box. When it is on, any changes to 
the enabled Audit Map Object forces the user to type a reason for the change. 

To disable this feature for an enabled object—The DC Results Group in the graphic 
above—change the state to Off.

Parameter
Change

This function records old and new values that are displayed in the upper half of the 
Reason for Change dialog box (see “Reason For Change” on page 182).

On, Off, and Silent The following table describes the On, Off, and Silent states for audit map attributes, 
Change Description and Parameter.

Audit Map Attributes

State Change Description Parameter

On Reason for change required Records old and new values

Off Reason for Change dialog box does not 
display

Does not record old or new value 
changes

Silent Reason for Change dialog box does not 
display

Records old and new values
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Audit History Viewer
The Audit History Viewer is used to view historical 
audit data. This tool is used as a read-only viewer for 
audit records. The tool provides data filtering so that 
audit records can be viewed in different formats. 

Audit records that you can view with the Audit 
History Viewer are:

• Date and time the audit record was created.
• The user who triggered the audit event.
• The attribute that was changed.
• The old and the new values.
• The reason for the change.

Starting the Audit History Viewer

1. Double-click the Audit History Viewer icon in 
the left pane tree.

2. In the System Authentication dialog box, type 
Administrator for the login name and type your 
password if you have changed it. If not, type 
Administrator.

3. Click OK.

The Audit History Viewer displays.

Note: The audit records are stored in a permanent 
data store.
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Viewing an Audit History

1. In the Audit Objects pane, expand the objects 
tree until the object of interest displays.

2. Highlight an object and then click  (Detail 
Panel) to display audit record details.

Note: Click the column headers to sort the read-
only records columns.
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Filter Command

The filter allows you to categorize audit history 
records. 

1. Click  (Filter).
The Filter Audit Records pane displays.

2. Enter search criteria in the applicable text boxes.

3. Click Find Now.
You can filter audit records by:

• Name
• Date (and, before or after a date or between 

two dates)
• User name
• Matching whole words
• Case sensitivity

Commands

Toolbar
Menu Command Function

File Reload Refreshes the Audit History Viewer with the latest changes

Report Customize and then print a report of the selected Audit 
History Record

Print Preview Customize and then preview a report of the selected Audit 
History Record

Page Setup Customize the page setup of the Report printout

Go To Displays a list of applications that are currently running; 
select an application to go to that application

Visual Print Displays Print Dialog

Visual Print Preview Displays Print Preview

Exit Application Exits the Audit Map Configuration application

Exit AB Navigator Exits the AB Navigator application

View Filter Displays the filter pane on the top of the frame when 
selected. It allows the user to specify criteria that limits the 
amount of audit records in the Audit Record table.
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Access Control Administration
The Access Control Administration tool allows an 
administrator to manage the creation and deletion of:

• Users
• Profiles

Also, Access Control allows an administrator to 
restrict or grant users access to features and functions 
of the software.

An administration user is always associated with the 
Administration User Group and cannot be deleted. 
And, only one administrator is allowed to modify 
Access Control data at one time. 

Starting the Access Control Administra-
tion Tool 

1. Start the following:
– Data Collection services: Start > Programs > 

Applied Biosystems > Data Collection > 
Run Data Collection 3730 v2.0.

– Administrator application: Start > Programs 
> Applied Biosystems > Administrator.

2. Double-click the Access Control Administration 
icon in the left pane tree.

3. In the System Authentication dialog box, type 
Administrator for the login name and type your 
password if you have changed it. If not, type 
Administrator.

IMPORTANT! You must start Data Collection 
services in order for AB Navigator to function 
properly. 



Chapter 8 Audit Trails and Access Control
Access Control Administration

194 Applied Biosystems 3730/3730xl DNA Anaylzer User 

Notes

4. Click OK to display Access Control 
Administration 

Access Control Administration Tool Bar 

Icon Command Function

Save Saves changes

Reload Refreshes the Access Control Administration window with the latest changes

Report Customize and print a report of the selected Access Control Indentifiers

Duplicate Duplicates the selected entity

Delete Deletes the selected entity

Find Finds a specific identifier

New User Opens a new user window

New Application Create a new application (not needed for Data Collection software)

New Profile Opens a new profile window

Expand Expands all tree nodes making all items visible

Collapse Collapses all tree nodes making only the root tree items visible
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Exporting User Settings, Applications, and Group Profiles
Exporting and Importing the Access Control 
Administration settings can be useful if the same 
users and group profiles will be shared amongst many 
computers. This procedure can minimize the time 
needed to re-create the access control settings on the 
other computers. The Administrator will only need to 
create the User, Application, and Group profiles 
settings on one computer, and then import these 
settings to the other computers.

1. Select File > Export Database.

2. Choose a local or network location and type in a 
file name for the export file, and click Save.

3. The Export Users dialog box displays after a 
successful export.
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Importing User Settings, Applications, and Group Profiles
Importing the Access Control Administration settings 
will over-write any existing User, Application, and 
Profile settings. The Audit Map Configuration and 
Audit History Viewer will not be affected.

1. On the computer that you want to import the 
Access Control Administration database, enter 
the Access Control Administration.

2. Select File > Import Database.

3. Locate the file that was exported, and 
click Open.

4. The Import Users dialog box displays after a 
successful import.
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Password Policies
1. Customize passwords by accessing Settings > 

Password Policies.

The following fields are customizable:
• Max Login Attempts:

Sets the maximum number of failed login 
attempts allowed before the user account is 
suspended. The User will not be able to log in 
again until the suspension time period is over, or 
the Administrator re-sets the user status to 
Active.

• Set User State:
– Remain active - Users are never suspended, 

even though they exceed the maximum login 
attempts.

– Suspend for x hour(s) - Users are suspended 
for the set number of hours if they exceed the 
maximum login attempts. The user can not 
login to the Data Collection viewer until the 
end of the suspension, at which time the User's 
"Suspended" status reverts to "Active."

• Password:
– Password Lifetime - At the end of the set 

period, users will be asked to change their 
password.

– Password Grace Logins - Sets the number of 
times that users are able to login with their old 
password before they are forced to change 
their password.
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• Password Reusability:

– Password Reuse Period - Sets the number of 
days that users are prevented from re-using 
their old password(s). For more information 
see, “User Password Change” on page 199.

– Passwords kept per user - Sets the number of 
the latest passwords chosen by each user that 
will be remembered.

Note: The password history can be cleared 
by the Administrator by Clicking Clear 
Password History for a particular user. If the 
user forgets his password the Administrator 
can reset his password at any time without 
being required to provide the old password.
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User Password Change 
Users can change their passwords by going to the 
Administrator tool.

1. Select Settings > Change Password.

2. Users must type in their old password, and then 
their new password twice in the Change 
Password dialog box.
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Type Selection

In the left pane tree, Users and Applications are types. 
When you select a type, the List of Users pane 
displays a list of identifiers of the type selected.

Name Selection

When you highlight a name, properties of that name 
display in the User Properties pane. 

Properties Panes

Access control identifiers have an additional drop-list 
labeled “Control Properties.” This defines the access 
level an individual is allowed in the Data Collection 
software. 

Three default profiles and their functional access 
levels:

• Administrator: Complete access to Instrument 
Protocols, Instrument Operation, Instrument 
Maintenance

• Scientist: Complete access to Instrument 
Protocols, Instrument Operation, Instrument 
Maintenance

• Technician: Access to Instrument Operation and 
Maintenance 

The broad functional access levels are further 
described below:

• Instrument Protocols include: Run Module 
Operations, Results Group Operations, Analysis 
Protocol Operations, Instrument Protocol 
Operations and Reextraction.

• Instrument Operation include: Plate Operations, 
Event Log, and Instrument Control Operations.

• Instrument Maintenance: Spatial Calibration 
Operations, Manual Instrument Control, Service 
Tools, and Wizards.

IMPORTANT! Do not remove any applications from 
the default list in the left pane tree.
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Commands

Frequently used commands appear in the application 
toolbar. Tool tip help text appears when you place the 
cursor over a button in the toolbar.

• Save:  Commits changes in the Admin Tool 
to data store and is accessible from the menu bar, 
keyboard shortcut, or toolbar.

• Exit: Invoked by the standard upper-right-corner 
control or, by the Files/Exit menu selection. If 
you have updated memory but have not yet 
committed changes to data store, the application 
asks, “Information has been modified, Save 
changes?” The message box provides buttons for 
Yes, No, and Cancel.

• Duplicate:  Duplicates the selected 
indentifier. Duplicate is accessible from the 
menu bar and toolbar.

• Find:  locates the name specified in the text 
field in the navigator tree

• Print: Prints all or some identifiers in various 
formats selected from the dialog shown below. 
Go to File > Report  to display the Print 
Options dialog box.

\
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Creating a New User

1. Click the New User icon .

The New User dialog displays.

2. Click Next.

The Configure pane displays.

IMPORTANT! You must set a default password for 
each new user.
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3. Complete the information in the window.

4. Click Set Password.

The Change Password dialog box displays.

5. Complete the new password and click OK.

6. Click Finish to complete the creation of a new 
user.

7. Click  (Save).

8. Click Next.



Chapter 8 Audit Trails and Access Control
Creating a New User

204 Applied Biosystems 3730/3730xl DNA Anaylzer User 

Notes

9. (Optional) The Show EULA and Pre-Expire 
checkboxes are selected by default. 

• If Show EULA checkbox is enabled, the 
first time the user logs into the 3730/3730xl 
Data Collection Software, the End User 
License Agreement displays. Uncheck this 
option if you do not want to force users to 
view the EULA.

• If Pre-Expire checkbox is enabled, users are 
forced to personalize their passwords when 
they log into the 3730/3730xl Data 
Collection Software with the default 
password for the first time. Uncheck this 
option if you do not want to give the user 
the ability to change the default password.

10. Click  (Save).

User Properties
A user must be assigned to a profile, which allows the 
administrator to grant or deny a user the right to 
execute functions defined by applications.

When one user is selected in the left navigator tree, 
the user profile displays in the User Properties pane.
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Default Profiles

User Groups

Default profiles show the access each user group has. 
The default user groups and their default profiles are:

• Administrator: Complete access to Instrument 
Protocols, Instrument Operation, Instrument 
Maintenance

• Scientist: Complete access to Instrument 
Protocols, Instrument Operation, Instrument 
Maintenance

• Technician: Access to Instrument Operation and 
Maintenance 

Inherited Rights

The broad functional access levels are further 
described below:

• Instrument Protocols include: Run Module 
Operations, Results Group Operations, Analysis 
Protocol Operations, Instrument Protocol 
Operations and Reextraction.

• Instrument Operation include: Plate Operations, 
Event Log, and Instrument Control Operations.

• Instrument Maintenance: Spatial Calibration 
Operations, Manual Instrument Control, and 
Miscellaneous Operations.

Default access 
rights for 
Technicians
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Overriding Inherited Rights

Selecting the OIR check box, allows the 
Administrator to change the default rights inherited 
from a parent node. The Scientist Group, for example, 
is allowed Full System Control, because they have the 
ability to execute any function contained under the 
FoundationDataCollection node. In another words, all 
the sub nodes under FoundationDataCollection is 
checked because the Executable rights are “inherited” 
from the FoundationDataCollection node.

To override the inherited rights of a User Group:

1. Deselect the OIR check box next to the function 
you want to change.

2. Select the Execute check box to allow access to 
the feature or deselect the Execute check box to 
deny access to the feature.

To override the inherited rights of a group:

1. Deselect the OIR check box next to the function 
you want to deny. In the example to the right, the 
Scientist group is denied access to Instrument 
Operation.



Creating a New Profile
Overriding Inherited Rights

Applied Biosystems 3730/3730xl DNA Anaylzer User 207

Notes

8

Creating a New Profile
1. Click the New Profile icon 

The New Profile dialog displays.

2. Click Next.
The Configure pane displays.

3. Complete:
a. Profile properties.
b. Select OIR and/or Execute.

Execute: Select this to give access to the 
function to any user assigned to this Profile.
OIR: Select this to override inherited rights. 
Any lower level in the hierarchy inherits the 
access rights of the node above it.
To override inherited defaults, check the 
OIR check box. This allow the 
administrator to grant or deny a group’s 
ability to execute a specific function on a 
lower level of the hierarchy tree.

4. Click Next.
The Summary pane displays the properties and 
associations of the new profile name.

5. Click Finish to complete the creation of a new 
User Profile Name.
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AParts List

Description Part No

3730 36-cm capillary array 4331247

3730 50-cm capillary array 4331250

3730xl 36-cm capillary array 4331244

3730xl 50-cm capillary array 4331246

3700/3730 BigDye Terminator v3.1 Sequencing Std 4336943

3700/3730 BigDye Terminator v1.1 Sequencing Std 4336799

Matrix Standard Set DS-33 4318254

HiDi formamide - 25 mL 4311320

POP-7 (5 bottles of 25ml) 4335615

Buffer (10X) with EDTA - 500 mL 4335613

Buffer (10X) with EDTA - 4L 4318976

96-well Sample Plates w/barcode 4306737

96-well Sample Plates, no bar code N801-0560

96-well plate septa 4315933

96-well Plate Base (septa sealed) 4334873

96-well Plate Base (heat sealed) 4334875

96-well Plate Retainer (Septa sealed) 4334869

96-well and 384-well Plate Retainer (heat sealed) 4334865

384-well Sample plates with barcode 4309849

384-well Plate septa 4315934

384-well Plate Base (Septa-Sealed) 4334874

384-well Plate Base (Heat-Sealed) 4334877

384-well Plate retainer (Septa-Sealed) 4334868

Heat Seal film - 3-mil 4337570
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BG5, G5-RCT, Any4Dye, and Any5Dye Dye Sets

Dye Sets G5 and G5-RCT For Fragment Analysis

Overview Even small levels of crosstalk could be a concern for users of the 3730/3730xl 
instruments who perform fragment analysis as well as for applications with a high 
dynamic range. In fragment analysis applications that have few sample peaks and 
varying peak intensities, a crosstalk peak may appear as a real sample peak and be 
incorrectly identified as an allele. Crosstalk is not a concern with sequencing 
applications as there is a constant stream of peaks electrophoresing past the detector.

Dye Set G5-RCT To reduce crosstalk for fragment analysis applications, a new dye set has been created 
for Data Collection Software v2.0, called dye set G5-RCT (reduced crosstalk). G5-RCT 
uses the same chemistry as dye set G5 (6-FAM™, VIC® NED™, PET®, LIZ® dyes). This 
dye set reduces signal, but reduces potential crosstalk to a greater degree, so the 
reduction in signal-to-noise ratio is less pronounced than the reduction in signal overall. 
Higher concentration peaks can be used without going offscale – this results in a higher 
dynamic range for the G5-RCT dye set.

Recommenda-
tions for Using GS

or G5-RCT

Dye set G5-RCT may be particularly helpful for users performing fragment analysis 
with a 96 capillary array, as well as users interested in applications with a high dynamic 
range (large peaks much higher than small peaks). Most other users will prefer the G5 
dye set. 

Applied Biosystems supports:

• Fragment analysis on the 96-capillary array using G5-RCT only 
• G5 and G5-RCT on the 48-capillary array.
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Please see the chart that follows for more information about the advantages and issues to 
consider for each dye set.

Dye Set Advantages

G5-RCT Advantages:

• Potential crosstalk is reduced, which can improve allele calling accuracy 
for 96 capillary array or high dynamic range applications

• Higher dynamic range – higher concentration peaks can be used without 
peaks going off scale

Issues: 

• Signals are reduced compared to signals generated with G5 dye set

• It is essential to run a spectral calibration each time the capillary array is 
replaced or moved in the detection cell heater

G5 Advantages:

• Higher sample signals compared to the G5-RCT dye set, as more light is 
collected from the CCD

• While we recommend spectral recalibration when the capillary array is 
replaced or moved in the detection cell heater, spectral recalibration is 
needed less often with G5 than with G5-RCT

• Optimized for the highest signal-to-noise ratio

Issues:

• You may observe more crosstalk with this dye set compared to the G5-
RCT dye set, particularly on the 96 capillary array or in high dynamic range 
applications
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Creating a Spectral Calibration for the Any4Dye or Any5Dye 
Dye Sets
The steps to creating and running a customized 4- or 
5- DyeSet is similar to running a supported dye set.

The following example highlights the use of 
Any4Dye dye set; it works the same for Any5Dye dye 
set.

1. Create a spectral protocol for the 4-Dye dye set, 
specifying the appropriate protocol parameters.

2. Click OK to save the spectral protocol.

Note: Customize the Spectral parameters as 
needed. For more information see, step 5 on 
page 38.
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3. Click New in the plate manager to display the 
New Plate Dialog box.

4. Create a spectral plate for the Any4Dye dye set 
by completing the New Plate Dialog box.

5. In the Plate Editor, select the Instrument Protocol 
that you just created in the previous steps and 
click OK to save the plate.
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6. From the Run Scheduler, add this spectral plate to the Input Stack and run it.
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7. Confirm that spectral matrices for all capillaries pass. Override individual 
capillaries and rename calibration as needed.
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Regular Runs Using Any4Dye or Any5Dye Dye Sets

The following example highlights the use of 
Any4Dye dye set. This process works the same for 
Any5Dye set.

1. In the Protocol Editor, create a regular 
instrument run protocol for the Any4Dye dye set, 
and choose the appropriate default run module 
template. (You can create a customized run 
module in the module editor if desired).

2. In the Plate Manager, create a regular plate, 
selecting the Any4Dye instrument protocol you 
created in step 1.



Appendix B
Regular Runs Using Any4Dye or Any5Dye Dye Sets

218 Applied Biosystems 3730/3730xl DNA Analyzer User Guide

Notes

3. In the Plate Editor, select the Instrument Protocol that you just created in step 1, and 
click OK to save the plate.
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4. From the Run Scheduler, add this plate into the Input Stack and run it.
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